The FinancialEdge™

Reports Guide for Student Billing
Reports Guide for Student Billing

REPORTS BASICS. ................................................................. 1

Report Categories ............................................................... 2
Basic Reporting ................................................................. 4
  Accessing Reports .......................................................... 5
  Tabs ................................______________________________ 5
  Reporting Procedures ..................................................... 12

ACTION REPORTS .............................................................. 27

Action Listing ................................................................. 28
  General Tab ............................................................... 28
  Filters Tab ................................................................. 29
  Format Tab ................................................................. 30
Action Summary Report ....................................................... 34
  General Tab ............................................................... 35
  Filters Tab ................................................................. 36
  Format Tab ................................................................. 36
Actions by Association Report ............................................. 40
  General Tab ............................................................... 41
  Filters Tab ................................................................. 42
  Format Tab ................................................................. 42

ANALYSIS REPORTS ........................................................... 47

Aged Accounts Receivable Report ........................................ 48
  General Tab ............................................................... 49
  Filters Tab ................................................................. 50
  Address Tab .............................................................. 51
  Format Tab ................................................................. 52
Open Item Report ............................................................. 60
  General Tab ............................................................... 61
  Filters Tab ................................................................. 62
  Format Tab ................................................................. 63
Service and Sales Analysis Report ........................................ 74
  General Tab ............................................................... 75
  Filters Tab ................................................................. 76
  Format Tab ................................................................. 77
Service and Sales Trend Analysis Report ................................ 80
  General Tab ............................................................... 81
  Filters Tab ................................................................. 82
  Format Tab ................................................................. 82
BANK ACCOUNT REPORTS .................................................. 87

Bank Profile Report ......................................................... 88
  General Tab ............................................................. 88
  Filters Tab ............................................................. 89
  Format Tab ............................................................. 89
Bank Reconciliation Report .................................................. 92
  General Tab ............................................................. 93
  Format Tab ............................................................. 94
Bank Register Report ......................................................... 97
  General Tab ............................................................. 98
  Filters Button ......................................................... 99
  Format Tab ............................................................. 101

CUSTOM REPORTS ...................................................... 107

Creating Custom Reports .................................................. 108
Editing Exports for Custom Reports ........................................ 110

DEPOSIT AND RECEIPT REPORTS ................................. 111

Cash Receipts Report ..................................................... 112
  General Tab ............................................................. 112
  Filters Tab ............................................................. 114
  Format Tab ............................................................. 114
Deposit List ................................................................. 120
  General Tab ............................................................. 121
  Filters Tab ............................................................. 122
  Format Tab ............................................................. 122
Deposit Report .............................................................. 126
  General Tab ............................................................. 127
  Filters Tab ............................................................. 128
  Format Tab ............................................................. 128

PRODUCT AND BILLING ITEM REPORTS ......................... 133

Product and Billing Item List .............................................. 134
  General Tab ............................................................. 134
  Filters Tab ............................................................. 135
  Columns Tab .......................................................... 136
  Format Tab ............................................................. 137
Product and Billing Item Report .......................................... 140
  General Tab ............................................................. 141
  Filters Tab ............................................................. 142
  Format Tab ............................................................. 142

RECONCILIATION REPORTS ........................................... 147

Account Distribution Report ............................................ 148
  General Tab ............................................................. 149
  Filters Tab ............................................................. 150
  Format Tab ............................................................. 150
<table>
<thead>
<tr>
<th>Report</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aged Accounts Receivable Report</td>
<td>158</td>
</tr>
<tr>
<td>General Tab</td>
<td>158</td>
</tr>
<tr>
<td>Address Tab</td>
<td>159</td>
</tr>
<tr>
<td>Format Tab</td>
<td>160</td>
</tr>
<tr>
<td>Open Item Report</td>
<td>167</td>
</tr>
<tr>
<td>General Tab</td>
<td>168</td>
</tr>
<tr>
<td>Format Tab</td>
<td>168</td>
</tr>
<tr>
<td>ST TUDENT/INDIVIDUAL/ORGANIZATION REPORTS</td>
<td>181</td>
</tr>
<tr>
<td>Account Balance Report</td>
<td>182</td>
</tr>
<tr>
<td>General Tab</td>
<td>183</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>184</td>
</tr>
<tr>
<td>Format Tab</td>
<td>184</td>
</tr>
<tr>
<td>Family Directory</td>
<td>189</td>
</tr>
<tr>
<td>General Tab</td>
<td>190</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>191</td>
</tr>
<tr>
<td>Relationship Filters Tab</td>
<td>192</td>
</tr>
<tr>
<td>Address Tab</td>
<td>192</td>
</tr>
<tr>
<td>Relation Address Tab</td>
<td>194</td>
</tr>
<tr>
<td>Columns Tab</td>
<td>195</td>
</tr>
<tr>
<td>Format Tab</td>
<td>196</td>
</tr>
<tr>
<td>Individual Profile Report</td>
<td>202</td>
</tr>
<tr>
<td>General Tab</td>
<td>203</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>204</td>
</tr>
<tr>
<td>Format Tab</td>
<td>204</td>
</tr>
<tr>
<td>Organization Profile Report</td>
<td>207</td>
</tr>
<tr>
<td>General Tab</td>
<td>208</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>209</td>
</tr>
<tr>
<td>Format Tab</td>
<td>209</td>
</tr>
<tr>
<td>Payment Responsibility Report</td>
<td>212</td>
</tr>
<tr>
<td>General Tab</td>
<td>213</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>214</td>
</tr>
<tr>
<td>Format Tab</td>
<td>214</td>
</tr>
<tr>
<td>Record Statistics Report</td>
<td>219</td>
</tr>
<tr>
<td>General Tab</td>
<td>220</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>221</td>
</tr>
<tr>
<td>Format Tab</td>
<td>221</td>
</tr>
<tr>
<td>Student Profile Report</td>
<td>225</td>
</tr>
<tr>
<td>General Tab</td>
<td>226</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>227</td>
</tr>
<tr>
<td>Format Tab</td>
<td>227</td>
</tr>
<tr>
<td>TRANSACTION REPORTS</td>
<td>231</td>
</tr>
<tr>
<td>Account Activity Report</td>
<td>233</td>
</tr>
<tr>
<td>General Tab</td>
<td>234</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>235</td>
</tr>
<tr>
<td>Format Tab</td>
<td>236</td>
</tr>
<tr>
<td>Account Distribution Report</td>
<td>242</td>
</tr>
<tr>
<td>General Tab</td>
<td>243</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>244</td>
</tr>
<tr>
<td>Format Tab</td>
<td>244</td>
</tr>
<tr>
<td>Report</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Advance Deposit Report</td>
<td>249</td>
</tr>
<tr>
<td>General Tab</td>
<td>250</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>251</td>
</tr>
<tr>
<td>Columns Tab</td>
<td>252</td>
</tr>
<tr>
<td>Format Tab</td>
<td>252</td>
</tr>
<tr>
<td>EFT Report</td>
<td>257</td>
</tr>
<tr>
<td>General Tab</td>
<td>258</td>
</tr>
<tr>
<td>Format Tab</td>
<td>258</td>
</tr>
<tr>
<td>Financial Aid Schedule Detail Report</td>
<td>261</td>
</tr>
<tr>
<td>General Tab</td>
<td>262</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>263</td>
</tr>
<tr>
<td>Columns Tab</td>
<td>264</td>
</tr>
<tr>
<td>Format Tab</td>
<td>265</td>
</tr>
<tr>
<td>Financial Aid Schedule Summary Report</td>
<td>270</td>
</tr>
<tr>
<td>General Tab</td>
<td>271</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>272</td>
</tr>
<tr>
<td>Address Tab</td>
<td>272</td>
</tr>
<tr>
<td>Format Tab</td>
<td>274</td>
</tr>
<tr>
<td>Project Distribution Report</td>
<td>278</td>
</tr>
<tr>
<td>General Tab</td>
<td>279</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>280</td>
</tr>
<tr>
<td>Format Tab</td>
<td>280</td>
</tr>
<tr>
<td>Sales Tax Report</td>
<td>285</td>
</tr>
<tr>
<td>General Tab</td>
<td>286</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>287</td>
</tr>
<tr>
<td>Format Tab</td>
<td>287</td>
</tr>
<tr>
<td>Transaction List</td>
<td>292</td>
</tr>
<tr>
<td>General Tab</td>
<td>293</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>294</td>
</tr>
<tr>
<td>Format Tab</td>
<td>294</td>
</tr>
<tr>
<td>Tuition Refund Plan Report</td>
<td>301</td>
</tr>
<tr>
<td>General Tab</td>
<td>302</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>303</td>
</tr>
<tr>
<td>Format Tab</td>
<td>304</td>
</tr>
<tr>
<td>Unapplied Credit Report</td>
<td>308</td>
</tr>
<tr>
<td>General Tab</td>
<td>309</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>310</td>
</tr>
<tr>
<td>Format Tab</td>
<td>310</td>
</tr>
<tr>
<td>INDEX</td>
<td>319</td>
</tr>
</tbody>
</table>
Reports Basics

Contents

Report Categories ................................................. 2
Basic Reporting ...................................................... 4
Accessing Reports .................................................. 5
Tabs ................................................................. 5
  General Tab ...................................................... 6
  Filters Tab ....................................................... 7
  Format Tab ....................................................... 7
  Address Tab .................................................... 8
  Columns Tab ..................................................... 10
  Relation Address Tab ......................................... 10
  Relationship Filters Tab ..................................... 11
Reporting Procedures ........................................... 12
  Creating Reports ............................................... 12
  Printing Reports ............................................... 20
  Previewing Reports ........................................... 22
  Exporting Reports ............................................ 22
  Sending Reports as Email ................................. 24
Student Billing includes many standard reports to help you produce and view information you need quickly and easily. Reports in Student Billing are valuable tools for monitoring, evaluating, and distributing information about your school’s tuition, fees, and the individuals or organizations that pay these.

This chapter explains the basics of Reports, including procedures for creating, printing, previewing, exporting, and sending reports as email. Each report is described in detail in the chapter for that report category, except for pivot reports which are discussed in the Pivot Reports Guide for The Financial Edge.

Report Categories

In Student Billing, reports are divided into categories: Action Reports, Analysis Reports, Bank Accounts Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Student/Individual/Organization Reports, and Transaction Reports.

Action Reports
• Action Listing
• Action Summary Report
• Actions by Association Report

Analysis Reports
• Aged Accounts Receivable
• Open Item Report
• Service and Sales Analysis Report
• Service and Sales Trend Analysis Report

Bank Account Reports
• Bank Profile Report
• Bank Reconciliation Report
• Bank Register Report

Deposit and Receipt Reports
• Cash Receipts Report
• Deposit List
• Deposit Report

Product and Billing Item Reports
• Product and Billing Item List
• Product and Billing Item Report

Reconciliation Reports
• Account Distribution Report
• Aged Accounts Receivable Report
• Open Item Report

Student/Individual/Organization Reports
• Account Balance Report
• Family Directory
• Individual Profile Report
• Organization Profile Report
• Payment Responsibility Report
• Record Statistics Report
• Student Profile Report

**Pivot Reports**

**Transaction Reports**
• Account Activity Report
• Account Distribution Report
• Advance Deposit Report
• EFT Report
• Financial Aid Schedule Detail Report
• Financial Aid Schedule Summary Report
• Project Distribution Report
• Sales Tax Report
• Transaction List
• Tuition Refund Plan Report
• Unapplied Credit Report

Pivot reports are available only if you have Microsoft Excel 2000 or Excel XP.
The Pivot Reports category appears on the Reports page only if you have Microsoft Excel 2000 or Excel XP.

**Basic Reporting**

The Reports page is the central location for reporting in *Student Billing*. From the navigation bar, select *Reports* to access the Reports page. This page contains links to each report category. When you select a link, the program displays a list of the reports in that category.
Accessing Reports

To select a report, click the link for the category of reports you need from the Reports page. For example, click **Transaction Reports**.

![Image of report selection](image)

On the Transaction Reports page, select **Account Activity Report** from the list on the left. Saved account activity reports appear on the right of the screen. You can open one of the saved reports or create a new report. To open a saved report, select the report type and double-click the report in the frame on the right.

**Tabs**

Whether you create a new report or open a saved report, a screen appears with tabs to specify how the report should look and the information included in the report. Most reports include the General, Filters, and Format tabs. Some reports also contain the Columns or Addresses tab. To navigate among report tabs, select the tab itself or click **Back** and **Next** at the bottom of the screen. Once you learn to run one report, it is easy to run other reports because many of the tabs have similar features.

Reports in each category have common tabs with similar selections. Remember that records must satisfy all parameter settings you select for the report before they are included in the report.

Following are pictures of each tab in **Reports in Student Billing**. Keep in mind that options, fields, and other selections vary from report to report. See the chapter in this guide for the report category for more details about each report.
General Tab

On the General tab, you can define parameters and select information to include in the report. All Student Billing reports use the General tab. Typical selections on General tabs include setting date ranges, creating an output query of records included in the report, and setting the report orientation.
Filters Tab

On the Filters tab, you include records based on selected criteria. For example, you can run a Flex Spending Plan Report and include only employees with a status of Active. Employees with other statuses, such as Terminated or Inactive, do not appear on the report. All Student Billing reports use the Filters tab except the Bank Register Report, which uses the Filters button found on the General tab. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Format Tab

On the Format tab, you designate the format of the report. Settings on this tab determine the appearance of the report. You can create headings, page footers, and report footers. You can select to include the list of report criteria on the report, select the format for displaying monetary amounts, select the font size, and select colors for the report. On some reports, you can select additional report details and order information on the report. All Student Billing reports use the Format tab.
The list on the left of the screen displays formatting options for the report. When you select an item in the list, the right side of the screen changes to present selections for that section of the report. Formatting options can vary for each report. For information about formatting a specific report, read about the report in its respective chapter.

**Address Tab**

On the Address tab, you select the address to use when printing address information in a report. The program compares the parameters you define on this tab with address information entered on the Addresses tab of records to identify the address to use.
On this tab, you select a validation date and then define the order in which the program evaluates address types. The program first checks the validation date, then seasonal addresses, other address types (in the order you specify), and attributes. The first address found on the record that meets the defined parameters is used in the report. You can specify what to do if no valid address is found.
Columns Tab

On the Columns tab, you select the columns to appear on the report and the order in which they appear. In the **Width** column, you can set the width of each column in inches. The **Report Width** label below the grid shows the total width of the columns plus their margins. If the label is red, it indicates that the width of the columns exceeds the page width.

![Columns Tab Image](image)

Relation Address Tab

On the Relation Address tab, you select the address to use when printing relationships’ address information in a report. The program compares the parameters you define on this tab with address information entered on the Addresses tab of relationship records to identify the address to use.
On this tab, you select a validation date and then define the order in which the program evaluates address types. The program first checks the validation date, then seasonal addresses, other address types (in the order you specify), and attributes. The first address found on the record that meets the defined parameters is used in the report. You can specify what to do if no valid address is found.

**Relationship Filters Tab**

On the Relationship Filters tab, you can select filters to determine which relationship types to include in the report. For example, to include only mothers and fathers of students, you select Mother and Father as Relationship Types filters.
Below the filters grid, you can define additional criteria for including or excluding relationships. For example, if you select “Ignore” in the Payers field, the program does not consider payers when processing the report.

**Reporting Procedures**

You can use a variety of parameters to define the output for reports in *Student Billing*. Saving these parameters also makes future reporting easier. The procedures here provide instructions for creating, printing, previewing, sending as email, and exporting reports. While these procedures are written specifically for an Account Activity Report, you can use these same basic steps as a model for all reporting in *Student Billing*.

**Creating Reports**

Creating a report is a quick and easy process. For this procedure we focus on creating a Family Directory report, which is a commonly used report in *Student Billing*. The Family Directory lists students and their relationships with address information. This report is typically used by teachers and other staff and is often run at the beginning of each semester.

1. From the Reports page, click Student/Individual/Organization Reports. The Student/Individual/Organization Reports page appears with a list of all student/individual/organization reports on the left.
2. In the list on the left, select **Family Directory**.

![Image of Reports - Student/Individual/Organization Reports]


![Image of New Family Directory]

4. To select how many columns to appear, in the **Show in [ ] column(s)** field, select “1”, “2”, “3”, or “4”.

5. To combine entries for spouses, mark **Combine entries for each spouse pair**. For example, if a husband and wife have separate records, marking the checkbox combines their contact information into a single entry in the directory, such as Mr. & Mrs. William Smith.

6. To create a static query of the student records included in the report, mark **Create an output query of students**.
7. In the **Report orientation** field, select “Portrait” or “Landscape” as the report format.

8. Click **Next** or select the Filters tab.

9. To include only specific records in the report, make filtering selections. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.
10. When you finish selecting filters, click **Next** or select the Relationship Filters tab.

![New Family Directory](image1)

11. To include only types of student relationships in the report, make filtering selections in the grid. To further limit results, select “Ignore”, “Include only”, or “Exclude”, in the **Payers** and **Statement recipients** fields.

![New Family Directory](image2)
12. When you finish selecting relationship filters, click Next or select the Address tab.

13. When you finish selecting the addresses the program will use when printing students’ address information in the directory, click Next or select the Relation Address tab.
14. When you finish selecting the addresses the program will use when printing relationships’ address information in the directory, click Next or select the Columns tab.

![New Family Directory window](image1)

15. In the grid, select and format the columns to appear in the Family Directory.

![New Family Directory window](image2)
16. Click Next or select the Format tab.

17. On the Format tab, the right side of the screen changes as you make selections in the list on the left.

18. From the list, select **Headings**. The heading defaults to “Family Directory” in the **Title** field. You can leave this as the title for the report or enter your own.
19. In the **Subtitle** field, enter a subtitle for the report.

20. To make other formatting selections for the report, make a selection in the list on the left, for example, select **Detail**.

21. To print relationships’ contact information, make selections in the **Contact Types to include with Address** fields.
22. When you finish making formatting selections, click **Preview** to preview the report. A message appears telling you the program is processing the report. The report preview screen appears.

23. When you finish viewing, click the red X to close the report.

24. To save the new report, click **Save** on the action bar. The Save Report as screen appears.

25. In the **Report name** field, enter a name for the report.

26. In the **Description** field, enter more details about the report.

27. To allow other users to run or modify the report, the checkboxes.

28. Click **Save**. You return to the Student/Individual/Organization Reports page.

### Printing Reports

You can print a hard copy of a saved report without opening the report. Your selections on the Format tab of the report determine the information that prints on the report and how it is formatted.

For this procedure, we focus on printing an Account Activity Report. For more information about setting up your printer, see the Program Basics chapter of the *Program Basics Guide*.

#### Printing a report

1. From the Reports page, click **Transaction Reports**. The Transaction Reports page appears with a list of all transaction reports on the left.
2. In the list on the left, select Account Activity Report.

3. In the grid on the right, select the report to print.

4. From the menu bar, select **File, Print**. A message appears telling you the report is printing. When the report finishes printing, you return to the Transaction Reports page.
Previewing Reports

You can preview the format and information in a report without opening the report. We recommend previewing a report before printing or sending it to another person. By previewing, you can make sure you included the required information and that the report is formatted as you want it. For this procedure, we focus on previewing an account activity report.

➢ Previewing a report

1. From the Reports page, click Transaction Reports. The Transaction Reports page appears with a list of all transaction reports on the left.

2. In the list on the left, select Account Activity Report.

3. From the menu bar, select File, Preview. A message appears indicating the program is processing the report. The report preview screen appears.

4. When you are finished previewing the report, click the red X to close the screen. You return to the Transaction Reports page.

Exporting Reports

To use report information in another software application, for example, Microsoft Excel or Crystal Reports, you can export the report. When you export a report, you send report information from the database to another software application using a data file. You can export a report without opening the report.

For this procedure, we focus on exporting an account activity report in spreadsheet format.
Exporting a report

1. From the Reports page, click Transaction Reports. The Transaction Reports page appears with a list of all transaction reports on the left.

2. In the list on the left, select Account Activity Report.

3. From the menu bar, select File, Export. A message appears telling you the program is processing the report. When processing is complete, the Export screen appears.

4. In the Format field, select the file format. For this example, select “Excel 5.0 (XLS)”.

5. In the Destination field, select the file destination. For this example, select “Disk file”.

6. Click OK.
7. The Choose Export File screen appears. The program assigns a name in the **File name** field based on report type and system information. You can change this name.

![Choose Export File dialog box](image)

8. Navigate to the folder in which to save the export file.

9. Click **Save**. A message appears telling you the program is exporting the data. When the data has been exported to your file, you return to the Transaction Reports page.

### Sending Reports as Email

In **Student Billing**, you can share report information with other users through electronic mail. For example, you can send the results of a report to another user for further analysis or to use in other applications.

Before you can send a report to another user, you must first select a format (*dBase*, *Lotus 1-2-3*, *Microsoft Excel*) for the data file. The format determines the appearance of the report and the software applications in which you can open the data file.

You can send report information by email without opening the report. For this procedure we focus on sending the Family Directory created in “Creating Reports” on page 12.

> **Sending a report as email**

1. From the Reports page, click **Student/Individual/Organization Reports**. The Student/Individual/Organization Reports page appears with a list of student/individual/organization reports on the left.

2. In the list, select **Family Directory**. Saved family directory reports appear in the grid on the right.
3. In the grid, select the report to send in an email.

4. From the menu bar, select **File, Send as Mail**. A message appears indicating the program is processing the report. When processing is complete, the Export screen appears.

5. In the **Format** field, select the file format. For this example, select “Excel 5.0 (XLS)”.  
6. In the **Destination** field, select “Microsoft Mail (MAPI)”.  

7. Click **OK**. The Send Mail screen appears.

8. In the **To** field, enter an email address. For example, enter “cjones@internet.com”.

9. In the **Subject** field, enter the report title or other text describing the email content.
10. In the **Message** box, enter a message to the recipient.

![Send Mail window](Image)

11. Click **Send**. The report is sent as an attachment to your email message. You return to the Transaction Reports page.
Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Student/Individual/Organization Reports, and Transaction Reports. This chapter discusses Action Reports. For information about other report categories, see the chapter for that category.

Action Reports in *Student Billing* include:

- Action Listing
- Action Summary Report
- Actions by Association Report

### Action Listing

The Action Listing report provides a list of details about actions you select. This report is useful for tracking upcoming actions. For example, you can run the Action Listing at the beginning of the month to see what actions are scheduled for that month.

The Action Listing has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

### General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

An action is a task or activity that needs to be completed for a student, individual, or organization. Actions, for example, can include mailings, phone calls, and email messages.
Include actions with these dates. In the Action date field, you can select a date or date range for actions to include in the report. If you select <Specific range>, specify starting and ending dates in the Start date and End date fields.

Include actions with these action priorities. You can mark High, Normal, and Low to include actions only with certain priorities. You can select one, two, or all three priorities.

Include Incomplete actions/Complete actions. You can mark the checkboxes to include incomplete or complete actions, or both.

Create an output query of records. If you mark this checkbox, the program creates a query of the records included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Action Listing. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break? for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark *Print count per* or *Print count as a percentage of total* for the selected sorting category. To start the selected sorting category on a new page, mark *Page break on each new*.

**Page Footer.** Use *Page Footer* to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer](image)

**Miscellaneous.** Use Miscellaneous to specify how numbers appear on the report and to set the font size.

![Miscellaneous](image)
**Color Scheme.** Use *Color Scheme* to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave *Apply a Color Scheme* unmarked, the reports prints in black and gray.

---

**Action Summary Report**

The Action Summary Report provides a count of actions by action type, action status, or the user assigned to the action. Because this report is a summary, student, individual, and organization names do not appear.

The Action Summary Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

---

Tip: An action is any task or activity that needs to be completed for a student, individual, or organization. Actions, for example, can include mailings, phone calls, and email messages.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include actions with these dates. In the Action date field, you can select a date or date range for actions to include in the report. If you select <Specific range>, specify starting and ending dates in the Start date and End date fields.

Include actions with these action priorities. You can mark High, Normal, and Low to include actions only with certain priorities. You can select one, two, or all three priorities.

Include Incomplete actions/Complete actions. You can mark checkboxes to include either incomplete or complete actions, or both.

Create an output query of records. If you mark this checkbox, the program creates a query of the records included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Click Preview to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

![Image ofFilter Grid]

**Open.** Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters.** The **Filters** column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the **Include** column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose **Selected**.

**Selected Filters.** Filters you specify on the selection screen appear in the **Selected Filters** column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Action Summary Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to **Action Summary Report** in the **Title** field. You can leave this as the title for your report or enter your own.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to summarize the report by action type, action status, or to whom the action is assigned.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer screenshot](image)

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

![Miscellaneous settings screenshot](image)
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the report prints in black and gray.

![Color Scheme.png](attachment:Color_Scheme.png)

**Actions by Association Report**

The Actions by Association Report lists action details by student, individual, or organization association.

The Actions by Association Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

An action is any task or activity that needs to be completed for a student, individual, or organization. Actions, for example, can include mailings, phone calls, and email messages.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include actions with these dates. In the Action date field of the Include actions with these dates frame, you can select a date or date range for actions to include in the report. If you select <Specific range>, specify starting and ending dates in the Start date and End date fields.

Include actions with these action priorities. You can mark High, Normal, and Low to include actions only with certain priorities. You can select one, two, or all three priorities.

Include Incomplete actions/Complete actions. You can mark checkboxes to include either incomplete or complete actions, or both.

Create an output query of records. If you mark this checkbox, the program creates a query of the records included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

![Filters Tab](image)

**Open.** Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters.** The **Filters** column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the **Include** column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the **Selected Filters** column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Actions by Association Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

- You can double-click a filter in the grid to open the selection screen.
- A filter is a requirement records must meet to be included in a report. For example, if you apply the Action Types filter, only records with action types you select appear in the report.
Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.
**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports print in black and gray.
Analysis Reports

Contents

Aged Accounts Receivable Report ........................................... 48
General Tab. .......................................................................... 49
Filters Tab ............................................................................ 50
Address Tab ........................................................................... 51
Format Tab ............................................................................. 52
Open Item Report ................................................................. 60
General Tab. .......................................................................... 61
Filters Tab ............................................................................. 62
Format Tab ............................................................................. 63
Service and Sales Analysis Report ........................................ 74
General Tab. .......................................................................... 75
Filters Tab ............................................................................. 76
Format Tab ............................................................................. 77
Service and Sales Trend Analysis Report .............................. 80
General Tab. .......................................................................... 81
Filters Tab ............................................................................. 82
Format Tab ............................................................................. 82

Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Custom Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Student/Individual/Organization Reports, and Transaction Reports. This chapter discusses Analysis Reports. For information about other report categories, see the chapter for that category. For information about Pivot Reports, see the *Pivot Reports Guide* for *The Financial Edge.*

Analysis Reports in *Student Billing* include:

- Aged Accounts Receivable Report
An aging period is a time span used to classify payments as early, current, overdue, or other defined category for the purpose of granting payment discounts or incurring late fees or charges. Aging periods are defined in Configuration.

Aged Accounts Receivable Report

The Aged Accounts Receivable Report provides a list of charge balances distributed to aging periods. This report is useful for determining past due and current balances of records who own or are assigned activity. For example, you can run the Aged Accounts Receivable Report to quickly see past due balances of your school’s student, individual, and organization accounts.

The Aged Accounts Receivable Report is different than the Aged Accounts Payable Report. In Accounts Payable, payments are included or excluded based on the “age as of date”. In Student Billing, charges, payments, and credits are included based on the transaction date filters. The “aging as of date” is independent of the transactions.

For example, you have a $200 charge dated 03/15/05 that has a $100 payment dated 04/15/05. In the report, if you include transactions through 03/31/05 and use an aging date of 03/31/05, the student has a balance of $200. If you include transactions through 04/15/05 and use an aging date of 03/31/05, the student has a balance of $100.00. The aging date only determines the aging bucket in which balances will fall; it is not used as a filter.

The Aged Accounts Receivable Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Calculate aging as of.** In the Calculate aging as of field, select Today or select <Specific date> and enter a date.

**Include transactions with these dates.** In this frame, you can select a date, date range, or billing cycle for the transactions to include in the report. Make your selections in the Transaction date, Due date, and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Only include records with a balance greater than [ ] in aging period [ ].** You can limit the report to include only minimum balance amounts and selected aging periods. Mark the checkbox and enter the minimum amount to include in the report. All balance amounts less than or equal to the amount you enter are excluded from the report. Select <Current> or a specific aging period.

**Reduce balances by unapplied payments/credits.** Mark this option to include unapplied payments or credits.

**Reduce balances by ungenerated financial aid.** Mark this option to include ungenerated financial aid.

**Reduce balances by ungenerated advance deposits.** Mark this option to include ungenerated advance deposits.
Beginning with. Select which aging period, the oldest or most recent, receives unapplied payments or credits first.

Include these aging periods. Mark checkboxes to select the aging periods to include.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of the records or transactions included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab
On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Owners filter, only selected owners appear in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
Address Tab

On the Address tab, you select the address from which the program uses contact information. For more information about addresses, see the Records Guide for Student Billing.

Include contact information for addresses. You can mark this checkbox to include contact information on the report.

Validate addresses as of. Select Today, Tomorrow, Last day of this week, Last day of this month, or <Specific date> as the date to use when determining which address to check for contact information.

Consider seasonal addresses. Mark this checkbox to include seasonal addresses when checking for contact information.

If no seasonal addresses are found, consider these addresses. In the Addresses box, select an address type and click the right arrow to move it to the Addresses to consider, in order of importance box. Address types that you move to the Addresses to consider, in order of importance box are considered when checking for contact information. The first address type in the list that matches the date selected in the Validate addresses as of field is included. You can change the order of addresses in the Addresses to consider, in order of importance box by selecting an address type and clicking the up and down arrows next.

In the grid, you can include or exclude an address based on its attributes. In the Action column, select whether to include or exclude an address. In the Attribute Type column, select the type of attribute to use, and in the Value column, select the attribute value that an address must have to include or exclude it from the report.
If no address is found. In the *If no address is found* field, select what to do if the program finds no addresses that match the address types you selected. You can include records without an address or select an address type to use. If you select Print specific address in the If no address is found field, select the address type to use.

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Aged Accounts Receivable Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

Detail. Use Detail to make selections for the output of the report.

In the Report by field, select Payer Activity or Student Activity to determine how the report displays information. When you select “Student Activity”, the report displays each student and his corresponding activity. When you select “Payer Activity”, the report displays each payer (student, individual, or organization) and is broken down by the records the payer is responsible for.

Then select Show or Do not show transaction details. Show lists payers or students with their individual transaction information and balances. Do not show lists transactions without payer or student information.

Reporting By Payer Activity: Show transaction details
Reporting By Payer Activity: Do not show transaction details

<table>
<thead>
<tr>
<th>Community Services Inc.</th>
<th>Aged Accounts Receivable Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aging Balance For</td>
<td>Last Paid</td>
</tr>
<tr>
<td>Thomas Condon</td>
<td>$43,026.05</td>
</tr>
<tr>
<td>Grand Total:</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Reporting By Student Activity: Show transaction details

<table>
<thead>
<tr>
<th>Community Services Inc.</th>
<th>Aged Accounts Receivable Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aging Balance For</td>
<td>Last Paid</td>
</tr>
<tr>
<td>Thomas Condon</td>
<td>$43,026.05</td>
</tr>
<tr>
<td>Total for Thomas Condon</td>
<td>$0.00</td>
</tr>
<tr>
<td>Grand Total:</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Reporting By Student Activity: Do not show transaction details

<table>
<thead>
<tr>
<th>Community Services Inc.</th>
<th>Aged Accounts Receivable Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aging Balance For</td>
<td>Last Paid</td>
</tr>
<tr>
<td>Thomas Condon</td>
<td>$43,026.05</td>
</tr>
<tr>
<td>Total for Thomas Condon</td>
<td>$0.00</td>
</tr>
<tr>
<td>Grand Total:</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

If you report by student activity and select not to show transaction details, you can mark Group transactions by General Ledger receivable account information. The report will show GL information for the selected transactions.
Mark **Show transaction detail** to list the transaction date, type, ID, due date, aging period, and amount for each transaction that in a balance.

To summarize aging by product and billing item, mark **Include summary by product and billing item**. This creates a chart on the last page of the report totaling the amount due for each product and billing item under the appropriate aging period.

If you marked **Include contact information for addresses** on the Address tab, you can select whether to print the contact information for individuals and organizations. In the **Print** field, select All contact types or Selected contact types. If you choose Selected contact types, then select the types in the **Contact types** box and move them to the **Selected contact types** box.

**GL Sort/Break.** Use **GL Sort/Break** to select the order for general ledger account information to appear on the report and where breaks fall. You can use **GL Sort/Break** only if you marked **Group transactions by General Ledger receivable account information** in **Detail**. Sorting and breaking by general ledger accounts makes it easier to reconcile with **General Ledger**. **GL Sort/Break** sorts and breaks the entire report, whereas **Transaction Sort/Break** sorts and breaks each payer/student section within the report.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column. To create breaks, you can mark the checkbox in the **Break?** column.
If you mark the checkbox in the Break? column, the Break Header for frame is enabled so you can specify more information about the break for the selection in the Sort by column. For example, if you select Account Number in the Sort by column, and mark the checkbox in the Break? column, in the Text before value and Text after value fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count as a percentage of total for the selected sorting category. To start the selected sorting category on a new page, mark Page break on each new.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.
**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name.** The program displays the items you mark after the organization name in the report.

Selections in the **Individuals** and **Students** frames work the same way. In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration**.

In the **If not present select addressee/salutation from** field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

**Transaction Sort/Break.** Use **Transaction Sort/Break** to select the order for transactions to appear on the report and where breaks fall. **Transaction Sort/Break** sorts and breaks each payer/student section within the report, whereas **GL Sort/Break** sorts and breaks the entire report.
To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

---

**Open Item Report**

The Open Item Report lists charges that have not been completely paid and the amount remaining to be paid as of a selected date. This report is useful for reconciling to the general ledger.

To view activity for a specific date range, run an Account Activity report, which is designed to filter all activity for a specific date range. Keep in mind, the Open Item and Aged Accounts Receivable reports are designed to view the balance of your outstanding charges. The date ranges you select are for charges only—unapplied payments prior to the date range are included in your beginning balance.

To review your unapplied activity, run the Unapplied Credit Report to see if any outstanding credits can be applied to their existing charges.
The Open Item Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Show charges open as of.** In the **Show charges open as of** field, specify a date for charges to include. Select Today, or select <Specific date> and enter a date. All charges open as of this date are included.

**Base charge open date on.** In the **Base charge open date on** field, select Transaction date or Post date to specify the date the charge is considered open. If you select Post date, advance deposits and transactions marked as Do not post do not appear in the report.

**Include charges with these dates.** In this frame, you can select a date, date range, or billing cycle for the charges to include in the report. Make your selections in the **Transaction date** and **Post date** fields.

If you select <Specific range>, specify start and end dates. If you leave the **Start date** field blank, all activity is included up to the end date. If you leave the **End date** field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Include unapplied payments and credits in [ ].** You can mark this checkbox to include payments and credits that have not been applied to a charge. You can display these in detail or summary.

- Select **Detail** to show each payment and credit as an additional line item.
- Select **Summary** to add the payments and credits and show a negative total in the balance column. The report displays payments and charges that are unapplied as of the date defined in the **Show Charges as of** field.
An output query of records includes individual, organization, and student records.

Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of the records or charges included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Owners filter, only selected owners appear in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Open Item Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to **Open Item Report** in the **Title** field. You can leave this as the title for your report or enter your own.
The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Detail.** Use **Detail** to make selections for the output of the report.

Mark **Include record open item information** to include open item information in detail or by summary. If you do not mark this option, you can use this report as a product and billing summary.

In the **Report by** field, select Student Activity or Payer Activity to determine how the report displays information.

Then select Show or Do not show transaction details. Show lists payers or students with their individual transaction information and balances. Do not show lists transactions without payer or student information.

The **Report in** field determines the layout of the report. Detail lists individual transaction information. Summary creates a column for each transaction type charge, payment, and credit, and issues a total for each.
### Reporting By Payer Activity in Detail: Show transaction details

**Detail**

- Include record open item information
- Report by: Payer Activity
- Report in: Detail and Show transaction details

#### Community Services Inc.

**Open Item Report**

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Transaction Type</th>
<th>Amount</th>
<th>Credit</th>
<th>Debit</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>07</td>
<td>Student</td>
<td>$14,422.00</td>
<td>$611.20</td>
<td>$600.00</td>
<td>$15,351.40</td>
</tr>
<tr>
<td>08</td>
<td>TUITON ARN</td>
<td>$3,900.00</td>
<td>$3,900.00</td>
<td>$0.00</td>
<td>$2,940.00</td>
</tr>
</tbody>
</table>

**Total for Student:**

$18,322.00

**Overall Total:**

$19,292.00

---

### Reporting By Payer Activity in Detail: Do not show transaction details

**Detail**

- Include record open item information
- Report by: Payer Activity
- Report in: Detail and Do not show transaction details

#### Community Services Inc.

**Open Item Report**

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Transaction Type</th>
<th>Amount</th>
<th>Credit</th>
<th>Debit</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>07</td>
<td>Student</td>
<td>$14,422.00</td>
<td>$611.20</td>
<td>$600.00</td>
<td>$15,351.40</td>
</tr>
<tr>
<td>08</td>
<td>TUITON ARN</td>
<td>$3,900.00</td>
<td>$3,900.00</td>
<td>$0.00</td>
<td>$2,940.00</td>
</tr>
</tbody>
</table>

**Total for Student:**

$18,322.00

**Overall Total:**

$19,292.00

---

**Grand Total:**

$37,634.00

$911.20

$8,390.00

$29,444.00

96.98%
## Reporting By Payer Activity in Summary: Show transaction details

### Detail

- Include record open item information

### Community Services Inc. Open Item Report

<table>
<thead>
<tr>
<th>Payment For</th>
<th>Credit Grade</th>
<th>Record Type</th>
<th>Charge Amount</th>
<th>Payments</th>
<th>Credits</th>
<th>Balance</th>
<th>% Unpaid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thomas Cordon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supervised Elizabeth Gordon</td>
<td></td>
<td></td>
<td>$94,002.90</td>
<td>$61,20</td>
<td>$6, 80</td>
<td>$28,723.98</td>
<td>31.17%</td>
</tr>
<tr>
<td>Alpine Terry Gordon</td>
<td></td>
<td></td>
<td>$94,775.88</td>
<td>$6,30</td>
<td>$6, 80</td>
<td>$28,723.98</td>
<td>31.17%</td>
</tr>
<tr>
<td>Grand Total for Thomas Cordon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$189,778.78</td>
<td>$67,50</td>
<td>$13, 60</td>
<td>$57,447.96</td>
<td>30.89%</td>
</tr>
</tbody>
</table>

---

## Reporting By Payer Activity in Summary: Do not show transaction details

### Detail

- Include record open item information

### Community Services Inc. Open Item Report

<table>
<thead>
<tr>
<th>Payment For</th>
<th>Credit Grade</th>
<th>Record Type</th>
<th>Charge Amount</th>
<th>Payments</th>
<th>Credits</th>
<th>Balance</th>
<th>% Unpaid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thomas Cordon</td>
<td></td>
<td></td>
<td>$26,925.00</td>
<td>$20,20</td>
<td>$6, 80</td>
<td>$6, 80</td>
<td>$26,925.00</td>
</tr>
</tbody>
</table>

---

*Page 1*
**Reporting By Student Activity in Detail: Show transaction details**

**Community Services Inc.**

**Open Item Report**

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Type</th>
<th>Date</th>
<th>Amount Due</th>
<th>Paid</th>
<th>Balance</th>
<th>% Paid</th>
</tr>
</thead>
<tbody>
<tr>
<td>226</td>
<td>TUTORS</td>
<td>01/01/20</td>
<td>$14,422.00</td>
<td></td>
<td>$13,311.60</td>
<td>92.00%</td>
</tr>
<tr>
<td>227</td>
<td>TUTORS</td>
<td>04/04/20</td>
<td>$950.00</td>
<td></td>
<td>$950.00</td>
<td>100.00%</td>
</tr>
<tr>
<td>228</td>
<td>TUTORS</td>
<td>07/07/20</td>
<td>$15,093.00</td>
<td></td>
<td>$15,093.00</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

**Community Services Inc.**

**Open Item Report**

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Type</th>
<th>Date</th>
<th>Amount Due</th>
<th>Paid</th>
<th>Balance</th>
<th>% Paid</th>
</tr>
</thead>
<tbody>
<tr>
<td>226</td>
<td>TUTORS</td>
<td>01/01/20</td>
<td>$14,422.00</td>
<td></td>
<td>$13,311.60</td>
<td>92.00%</td>
</tr>
<tr>
<td>227</td>
<td>TUTORS</td>
<td>04/04/20</td>
<td>$950.00</td>
<td></td>
<td>$950.00</td>
<td>100.00%</td>
</tr>
<tr>
<td>228</td>
<td>TUTORS</td>
<td>07/07/20</td>
<td>$15,093.00</td>
<td></td>
<td>$15,093.00</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

**Grand Total:** $39,955.00 $981.36 | $38,973.64 | 98.00%
CHAPTER 3

Reporting By Student Activity in Summary: Show transaction details

<table>
<thead>
<tr>
<th>Transactions</th>
<th>Current Balance</th>
<th>Record Type</th>
<th>Charge</th>
<th>Amount</th>
<th>Payments</th>
<th>Credit</th>
<th>Balance</th>
<th>Unapplied</th>
</tr>
</thead>
<tbody>
<tr>
<td>Director</td>
<td>$102,200.00</td>
<td>$102,200</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
</tr>
<tr>
<td>Secretary</td>
<td>$102,200.00</td>
<td>$102,200</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
<td>$102</td>
</tr>
</tbody>
</table>

If you report by student activity and select not to show transaction details, you can mark Group transactions by General Ledger receivable account information. The report will show GL information for the selected transactions.
To summarize open items by product and billing item, mark **Include summary by product and billing item**. This creates a chart on the last page of the report totaling the amount due for each product and billing item.

**GL Sort/Break.** GL Sort/Break to select the order for general ledger account information to appear on the report and where breaks fall. You can use GL Sort/Break only if you mark **Group transactions by General Ledger receivable account information** in **Detail**. Sorting and breaking by general ledger accounts makes it easier to reconcile with **General Ledger**.

GL Sort/Break sorts and breaks the entire report, whereas Transaction Sort/Break sorts and breaks each student/payer section within the report.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column. To create breaks, you can mark the checkbox in the **Break?** column.

If you mark the checkbox in the **Break?** column, the **Break Header for** frame is enabled so you can specify more information about the break for the selection in the **Sort by** column. For example, if you select Account Number in the **Sort by** column, and mark the checkbox in the **Break?** column, in the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

Name Formats. Use Name Formats to select the format of organization, individual, and student names in the report.

In the Organization frame, mark Use name followed by Organization ID, CFDA #, or Contact Name. The program displays the items you mark after the organization name in the report.

Selections in the Individuals and Students frames work the same way. In the Select addressee/salutation from field, if you select Record, in the Use field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the Select addressee/salutation from field, if you select Configuration, in the Use field, you can select a name format as defined in Configuration.
In the **If not present select addressee/salutation from** field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

Transaction Sort/Break. Use **Transaction Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information. When you select **Transaction Sort/Break**, you can sort sections within the report in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column. To create breaks between the sections you have sorted by, you can mark the checkbox in the **Break?** column.

In the **Break Header for <Sort by category>** frame, in the **Text before value** and **Text after value** fields, you can enter up to 30 characters in each field for information that prints immediately before and after each break.
In the Break Footer for $\text{Sort by category}$ frame, you can mark Print count per $\text{Sort by category}$ or Print count as percentage of total to print the information in the footer. To start a new page for the highest level break, mark Page break on each new $\text{Sort by category}$.

Service and Sales Analysis Report

The Service and Sales Analysis Report provides a summary of transaction information.

The Service and Sales Analysis Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Include transactions with these dates.** In the Transaction date field of the Include transactions with these dates frame, select a date, date range, or billing cycle for the transactions to include in the report.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Print a [ ] report in [ ] orientation.** Select to create a Detail or Summary report, and then select Portrait or Landscape orientation in the fields.

**Analyze by.** In the Analyze by field, you can select the primary analysis criteria. In the Sort field, select to sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.

**Then by.** In the Then by field, you can select secondary analysis criteria. In the Sort field, select to sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.

**Sort by.** If you are creating a detail report, to order the information, you can select a sorting category in the Sort by field. In the Sort field, select to sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.
Available Information/Print these columns (maximum 7). You can include up to seven columns of information on the report. The selections in the list change depending on whether you print the report in summary or detail. Use the right arrow to move a selected item from the Available Information box to the Print these columns (maximum 7) box.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of the records, charges, credits, or products and billing items included in the report. You can use the query later in other areas of Student Billing.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Service and Sales Analysis Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to Service and Sales Analysis Report in the Title field. You can leave this as the title for your report or enter your own.
The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

---

**Service and Sales Trend Analysis Report**

The Service and Sales Trend Analysis Report provides a comparison of transaction data.

The Service and Sales Trend Analysis Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

If you create a detail report, the dates you select in Detail on the Format tab appear in the report. For more information about the Format tab, see “Format Tab” on page 82.

Print a [ ] report in [ ] orientation. In the first field, select Detail or Summary as the type of report to create, and then select Portrait or Landscape in the next field. If you create a detail report, the dates you select in Detail on the Format tab appear in the report. If you create a summary report, no date or date range appears.

Analyze by. In the Analyze by field, you can select the primary analysis criteria. In the Sort field, select to sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.

Then by. In Then by field, you can select secondary analysis criteria. In the Sort field, select to sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.

Date order. If you are creating a detail report, the dates you select in Detail on the Format tab appear in the report. In the Date order field, select to sort the dates in ascending or descending order. You can mark Page break to print each on a separate page.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of the records, charges, credits, or products and billing items included in the report. You can use the query later in other areas of Student Billing.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

Open. Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click **Clear All Filters** to remove all previously selected filters from the report.

Filters. The **Filters** column lists all the filters for the report. You cannot edit this column.

Include. By default, in the **Include** column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the **Selected Filters** column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Service and Sales Trend Analysis Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

![Image of Headsings](image1.png)

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

![Image of Criteria](image2.png)

The heading defaults to Service and Sales Trend Analysis Report in the **Title** field. You can leave this as the title for your report or enter your own.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.
**Detail.** Use **Detail** to make selections for the output of the report.

Mark **Combine transactions by []**. In the field, select Months, Fiscal periods, Quarters, Years, or Billing Cycles to use in the report. In the **Show** field, you can generally define the selected time period, for example, All months or Calendar year-to-date. By combining transactions, you can run the report later with current information and avoid having to enter specific dates each time you run it. In the **Across** field, you can select Include all dates or <Specific range>. If you select <Specific range>, specify start and end dates.

Mark **Combine transactions by specific dates**. In the grid, select dates to use in the report. In the **Transaction Date** column, select a general time period, such as Month-to-date. Dates for the selected time period appear in the **Start** and **End** columns. If you select <Specific range>, you can modify the start and end dates of the **Start** and **End** columns.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.
Bank Account Reports

Contents

Bank Profile Report ................................................................. 88
   General Tab ................................................................. 88
   Filters Tab ..................................................................... 89
   Format Tab ..................................................................... 89
Bank Reconciliation Report ......................................................... 92
   General Tab ................................................................. 93
   Format Tab ..................................................................... 94
Bank Register Report .............................................................. 97
   General Tab ................................................................. 98
      Filters Button ............................................................ 99
   Format Tab ..................................................................... 101
Bank Account Reports in Student Billing include:

- Bank Profile Report
- Bank Reconciliation Report
- Bank Register Report

**Bank Profile Report**

The Bank Profile Report presents a summary profile of each bank you select. It provides basic bank account information including account number, routing number, and address information. This report shows the total debits and credits associated with each account. You can include adjustment transactions to further facilitate the reconciliation process.

The Bank Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you specify the records to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

- **Include this information.** Mark the checkboxes in this box to select bank information to include in the report. Some checkboxes appear only if you have the optional module Cash Management.

Visit our website at www.blackbaud.com for the latest documentation and information.
Include transactions with these dates. In this frame, in the Transaction date field, select a date, date range, or billing cycle for the transactions to include in the report.

If you select <Specific range>, specify start and end dates. If the Start date field is left blank, all activity is included up to the end date. If the End date field is left blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Bank Profile Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
The heading defaults to Bank Profile Report in the Title field. You can leave this as the title for the report or enter your own.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

![Image of Headings and Criteria sections]

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort in categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To print each category selected in the **Sort by** column on its own page, mark **Page break on each new**.
If you make no selections in the **Sort by** column in the grid, the program sorts by the bank ID in ascending order.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

**Bank Reconciliation Report**

You can run the Bank Reconciliation Report from **Reports** and from **Banks**.

The Bank Reconciliation Report provides details of the reconciliation of the bank register with the bank statement. In addition, this report lists all transactions included in the reconciliation process and all adjustments (such as fees, interest earned, voided checks) recorded in the register at the date of reconciliation.
With the Bank Reconciliation Report, you can troubleshoot issues before you receive your bank statement. From this report, you can print the last completed reconciliation or a pre-reconciliation. With the pre-reconciliation report, you can print a computer balance of the current account without actually reconciling the account.

The Bank Reconciliation Report has tabs on which you set parameters: General and Format. To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you specify the records to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Bank account.** In the Bank account field, you can select the bank account to use in the report.

**Print.** In the Print field, you can select to review a report of the previous reconciliation or create a pre-reconciliation report. Select:

- Last completed reconciliation to review a report of the previous reconciliation.
- Reconciliation using this information to create a pre-reconciliation report. Enter additional information in the Beginning balance, Reconciliation date, Ending balance, and Transaction date fields.

**Beginning balance.** The Beginning balance field is enabled only if you select Reconciliation using this information in the Print field and the account has not been reconciled before. After you reconcile once, the ending balance from the most recent reconciliation appears in the Beginning balance field and cannot be edited.

**Reconciliation date.** The Reconciliation date field is enabled only if you select Reconciliation using this information in the Print field. Enter the date of reconciliation.
For a pre-reconciliation report, use the ending balance from the Bank Account Reconciliation screen in Banks in the Ending balance field.

**Ending balance.** The Ending balance field is enabled only if you select Reconciliation using this information in the Print field. Enter the ending balance in this field.

**Show unreconciled transactions with these dates.** In the Show unreconciled transactions with these dates frame, in the Transaction date field, select a date or date range for unreconciled transactions to include in the report. The Transaction date field is enabled only if you select Reconciliation using this information in the Print field.

If you select <Specific range>, specify start and end dates. If the Start date field is left blank, all activity is included up to the end date. If the End date field is left blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Report orientation.** In this field, select Portrait or Landscape.

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Bank Reconciliation Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to Bank Reconciliation Report in the Title field. You can leave this as the title for the report or enter your own.
**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Detail.** Use **Detail** to select details specific to the Bank Reconciliation Report. You can mark checkboxes to print transaction details for reconciling the bank register and cash accounts to the statement.
Sort. Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort in categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

![Sort in a report](image)

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

![Page Footer in a report](image)
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer](image)

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

![Miscellaneous](image)

---

**Bank Register Report**

The Bank Register Report presents transactions in the register of a bank account. This report provides a summary statement or can be filtered to display specific information. For example, you can filter the report to display only outstanding deposits posted to **Student Billing**. In summary format, the report only gives a grand total for each transaction type. In detail format, the report lists each item and gives a grand total.
The Bank Register Report has tabs on which you set parameters: General and Format. To move between the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. You can filter bank transactions by clicking the Filters button found on the General tab. On these tabs you specify the records to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report. The Bank Register Report does not have a Filters tab, but you can filter bank transactions for this report by clicking the Filters button found on the General tab.

**Report format.** In the Report format field, select Detail or Summary. Detail lists each transaction as a separate item. Summary gives a total amount for each transaction type.

**Bank account.** In the Bank account field, select the bank account to include in the report.

**Show transactions with these dates.** In the Transaction date field of the Show transactions with these dates frame, select a date, date range, or billing cycle for transactions to include in the report.

If you select <Specific range>, specify start and end dates. If the Start date field is left blank, all activity is included up to the end date. If the End date field is left blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Report orientation.** If you create the report in summary format, select Portrait or Landscape. If you create the report in detail format, the program prints the report in landscape.

**Filters button.** The filters function for the Bank Register Report differs from all other reports. When you click Filters, the Transaction Filters for Student Billing & Accounts Receivable screen appears. Filter options General, System, Transaction Type, Transaction Status, and Post Status appear in a list on the left side of the screen.
Filters Button

When you click Filters, the Transactions Filters for Student Billing & Accounts Receivable screen appears. The list on the left of the screen displays filters for the report. When you select an item in the list, the right side of the screen displays selections for that filter.

**General.** Use General to establish date and amount ranges for payments and deposits. When you click in a column, you can select dates from a calendar or enter amounts using a calculator.

The bank account you select on the General tab determines the Transaction Filters screen that appears. For example, if you select Operating Account, the Transaction Filters for Operating Account screen appears.

**System.** Use System to select the programs to include in the report by marking checkboxes in the Show? column.

To reset all filters on the Transaction Filters screen to show all, click Reset Filters to Show All Transactions.
To quickly mark or unmark all checkboxes, click Select All or Deselect All.

**Transaction Type.** Use Transaction Type to select transaction types to include in the report by marking checkboxes in the Show? column. In the Start Number and End Number columns, enter beginning and ending transaction numbers.

**Transaction Status.** Use Transaction Status to select bank register transaction statuses to include in the report by marking checkboxes in the Show? column. In the Start Date and End Date columns, enter beginning and ending dates.
Post Status. Use Post Status to select post statuses to include in the report by marking checkboxes in the Show? column. In the Start Date and End Date columns, enter beginning and ending dates.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Bank Register Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the heading. You can include the page number and date in the heading and whether to include the heading on every page of the report.

The heading defaults to Bank Register Report in the Title field. You can leave this as the title for the report or enter your own.
The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

Detail. Use Detail to select details specific to the Bank Register Report. Mark the checkboxes to show distribution by transaction characteristics. If you have the optional module Projects and Grants and have defined transaction codes, additional checkboxes appear.

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.
To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.
Custom Reports

Contents

Creating Custom Reports .................................................. 118
Editing Exports for Custom Reports .................................. 119
Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Student/Individual/Organization Reports, and Transaction Reports. This chapter discusses Custom Reports. For information about other report categories, see the chapter for that category.

With Custom Reports, you can access and share reports you create using *Crystal Reports*. You can link Crystal report file with an export file in *Student Billing* and then save the linked report in your database. Once the files are linked, you and other program users can view or print custom Crystal reports directly from *Student Billing* without having to open *Crystal Reports*.

*The Financial Edge* includes one license for *Crystal Reports XI*. Clients creating custom reports using *Export* in *The Financial Edge* with *Crystal Reports* will need a license for each person creating custom reports. In addition, each license is associated with a particular product, which means if one person is reporting for both *The Financial Edge* and *The Raiser’s Edge*, that individual needs two *Crystal Reports XI* licenses. For information about purchasing additional *Crystal Reports XI* licenses, send an email request to solutions@blackbaud.com or contact your account representative.

## Creating Custom Reports

When setting up the Crystal report and the export file, remember that you can add as many or as few fields as you want to the Crystal report as long as those fields are also contained in the export file. You can add additional fields to the export file that are not in the Crystal report, but you cannot add fields to the Crystal report that are not in the export file. For more information about creating export files, see the *Export Guide*. For more information about creating Crystal reports, see the *Crystal Reports* help file.

The export file must be in one of these *.mdb* formats:

- Blackbaud Report Writer Database
- Microsoft *Access* 2.x Database
- Microsoft *Access* 95 Database
- Microsoft *Access* 97 Database
- Microsoft *Access* 2000 Database

**Creating a custom report**

1. From the Reports page, click *Custom Reports*. The Custom Reports page appears.

3. In the Select Export field, click the binoculars to locate the export file to use as the data source for the custom report. The Open screen appears.

4. From this screen you can select an existing export file or create a new export file.
   - To select an existing file, in the grid, select the file name and click Open. You return to the Custom Report screen and the selected export file name appears in the Select Export field.
   - To create a new export file, click Add New. The Create a New Export screen appears so you can create an export file to use with Custom Reports. After you create and save your export file, you return to the Custom Report screen and the selected export file name appears in the Select Export field. For more information about creating export files, see the Export Guide.

5. In the Select Crystal Report field, browse to the Crystal report file to link to the selected export file. The Open screen appears.


7. To automatically refresh the export file every time you view the report, mark Refresh Export. If you do not mark this checkbox, when you run the report, the program checks to see whether the export file is saved. If it is saved, the program uses the existing export file and does not update the data when you run the report. If the export file is not saved, the program generates a new export file and includes current data from the database.

8. To view a copy of the report on your screen before printing, click Preview. A copy of the report appears on your screen.

To print the report, click the Print button at the top of the preview screen.

Only exports saved in a Microsoft Access database file format (*.mdb) appear on the Open screen.

Make sure to format the export file in one of these *.mdb formats: Blackbaud Report Writer Database, Microsoft Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft Access 2000 Database.

Clicking Save Data with Report when you create the Crystal report has no effect on running the report from a Blackbaud application. To make the custom report “static” (data is not updated when you run the report) we recommend you unmark Refresh Export.
9. To save the report parameter file, click **File, Save** from the menu bar. The Save Report as screen appears.

10. Enter a name and description of the report in the **Report name** and **Description** fields.

11. To save the report and return to the Custom Reports screen, click **Save**.

12. To return to the Reports page, select **File, Close** from the menu bar.

### Editing Exports for Custom Reports

You cannot delete fields from an export file if the export is linked with a Custom Report. The **Remove** button is disabled in **Export**. You cannot delete an export file linked with a Custom Report. If you try, an error message appears.

You can edit an export file from the Custom Reports page. You can add additional fields to the export file not in the Crystal report, but you cannot add fields to the Crystal report not in the export file. Each time you run a saved Custom Report, the program checks to make sure the fields selected for the Crystal report are still included in the export file.

#### Editing an export file from an open Custom Report

1. Open a saved Custom Report to edit. The report opens to the General tab.

2. In the **Select Export** field, click the **Click to edit export** button next to the binoculars. The export file appears, displaying the Filters tab.

3. Make your edits on the Filters and Output tabs. To save your edits and return to the Custom Report screen, click **Save and Close**.

4. To print the report or to save and close the updated report, click **Print**.
Deposit and Receipt Reports

Contents

Cash Receipts Report ............................................................... 112
General Tab ................................................................. 112
Filters Tab ................................................................ 114
Format Tab .................................................................. 114
Deposit List ................................................................. 120
General Tab ................................................................. 121
Filters Tab ................................................................ 122
Format Tab .................................................................. 122
Deposit Report ............................................................ 126
General Tab ................................................................. 127
Filters Tab ................................................................ 128
Format Tab .................................................................. 128
Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Client Reports, Deposit and Receipt Reports, Product and Billing Item Reports, and Transaction Reports. This chapter discusses Deposit and Receipt Reports. For information about other report categories, see the chapter for that category. For information about Pivot Reports, see the *Pivot Reports Guide for The Financial Edge*.

Deposit and Receipt Reports in *Student Billing* include:

- Cash Receipts Report
- Deposit List
- Deposit Report

**Cash Receipts Report**

The Cash Receipts Report lists all cash receipts activity over a specified period of time.

The Cash Receipts Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.
Include transactions with these dates. In this frame, you can select a date, date range, or billing cycle for the transactions to include in the report. Make your selections in the Deposit date, Receipt date, and Entered on date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Include deposit numbers from [ ] To [ ]. In these fields, you can enter a range of deposit numbers to include in the report. If you leave both fields blank, the report includes all deposit numbers.

Include receipt numbers from [ ] To [ ]. In these fields, you can enter a range of receipt numbers to include in the report. If you leave both fields blank, the report includes all receipt numbers.

Show miscellaneous payment details. Mark this checkbox to separate payments into separate lines for Accounts Receivable, Student Billing, and Cash Receipts. This checkbox appears only if you have Cash Receipts.

Include deposits from [ ]. Mark Accounts Receivable, Student Billing, and Cash Receipts to include deposits from these programs in the report.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of the deposits or payments included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Payers filter, only payers you select appear in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Cash Receipts Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to Cash Receipts Report in the Title field. You can leave this as the title for your report or enter your own.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on a separate page and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to select details specific to the Cash Receipts Report. You can mark checkboxes to show distributions by transaction characteristic. If you have the optional module *Projects and Grants* and have defined transaction codes, additional checkboxes appear.

If you select one characteristic, you can select to show it as a separate column in the report. If you do not mark the **Show characteristic as a column in the main body**, the program creates additional lines in the report. If you select more than one characteristic, an additional line is created with each characteristic as a column.

If you select multiple characteristics, you can show the balancing account distribution. Mark **Show receivables/balancing account distribution** to see the corresponding debit and credit transactions for each receipt.

If you mark **Show transaction total**, the program prints an additional column for each receipt total.

To summarize transactions, mark **Include summary report for** and mark the checkboxes for each item to report on. The program creates a separate section at the end of the report.
**Grand Totals.** Use Grand Totals to select combined totals for transaction characteristics. You can mark checkboxes to show totals by transaction characteristic. If you have the optional module *Projects and Grants* and have defined transaction codes, additional checkboxes appear. A section appears at the end of the report with the grand total information.

**Sort/Break.** Use Sort/Break to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break? for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use Miscellaneous to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

---

**Deposit List**

The Deposit List displays summarized information for deposits you select.

The Deposit List has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include deposits with these dates. In this frame, you can select a date, date range, or billing cycle for the deposits to include in the report. Make your selections in the Deposit date, Entered on date, and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Include deposit numbers from [ ] To [ ]. In these fields, you can specify a range of deposit numbers to include in the report. Enter the deposit numbers or click the binoculars to search for a range. If you leave both fields blank, the report includes all deposit numbers.

Only include deposits whose amounts are greater than [ ]. You can mark this checkbox to enter a minimum deposit amount for deposits to include in the report. Deposits less than or equal to the amount you enter are excluded.

Include deposits from. Mark Accounts Receivable, Cash Receipts, or Student Billing to indicate which programs’ deposits to include in the report.

Create an output query of deposits. If you mark this checkbox, the program creates a query of the deposits included in the report. You can use the query later in other areas of Student Billing.

Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

Checkboxes for only the programs you have appear. For example, if you have only Accounts Receivable and Student Billing, a checkbox for Cash Receipts does not appear.
**Report orientation.** In the **Report orientation** field, select Portrait or Landscape.

**Filters Tab**

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

**Open.** Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters.** The Filters column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the Selected Filters column.

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Deposit List. When you select an item in the list, the right side of the screen displays selections for that section of the report.

---

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Post Statuses filter, only deposits with the selected statuses appear in the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.
To print each category selected in the Sort by column on its own page, mark Page break on each new.

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

---

**Deposit Report**

The Deposit Report provides a profile of deposits you select, including payment detail and bank information, with an optional detail section of transactions within each deposit.

The Deposit Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include deposits with these dates. In this frame, you can select a date, date range, or billing cycle for the deposits to include in the report. Make your selections in the Deposit date, Entered on date, and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Include deposit numbers from [ ] To [ ]. In these fields, you can specify a range of deposit numbers to include in the report. Enter the deposit numbers or click the binoculars to search for a range. If you leave both fields blank, the report includes all deposit numbers.

Only include deposits whose amounts are greater than [ ]. You can mark this checkbox to enter a minimum deposit amount for deposits to include in the report. Deposits less than or equal to the amount you enter are excluded.

Update the deposit printed on date when printing? You can mark this checkbox to update the Deposit ticket printed on field on the deposit record with the date the Deposit Report is printed.

Close deposit after printing. You can mark this checkbox to change the status of the deposit to Closed after the Deposit Report is printed.
Include deposits from. Mark *Accounts Receivable*, *Cash Receipts*, or *Student Billing* to indicate which programs’ deposits to include in the report.

Create an output query of deposits. If you mark this checkbox, the program creates a query of the deposits included in the report. You can use the query later in other areas of *Student Billing*.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

- **Open**. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.
- **Clear All Filters**. Click Clear All Filters to remove all previously selected filters from the report.
- **Filters**. The Filters column lists all the filters for the report. You cannot edit this column.
- **Include**. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.
- **Selected Filters**. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Deposit Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Post Statuses filter, only deposits with the selected posting statuses appear in the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization's name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to select and order payment methods for which to print details on the report. You can also select to print separate pages for each payment method and deposit.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.
Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use Miscellaneous to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.
Product and Billing Item Reports

Contents

Product and Billing Item List .................................................. 134
General Tab ................................................................. 134
Filters Tab ................................................................. 135
Columns Tab ............................................................. 136
Format Tab ................................................................. 137
Product and Billing Item Report ................................. 140
General Tab ............................................................. 141
Filters Tab ................................................................. 142
Format Tab ................................................................. 142
Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Student/Individual/Organization and Transaction Reports. This chapter discusses Product and Billing Item Reports. For information about other report categories, see the chapter for that category. For information about Pivot Reports, see the *Pivot Reports Guide for The Financial Edge*.

Product and Billing Item Reports in *Student Billing* include:

- Product and Billing Item List
- Product and Billing Item Report

### Product and Billing Item List

The Product and Billing Item List provides a summarized list of products and billing items.

The Product and Billing Item List has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

### General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

![New Product and Billing Item List](image)

**Include products and billing items with these valid dates.** In this frame, you can select a date, date range, or billing cycle for the products and billing items to include in the report. Make your selection in the **Valid dates within** field.

If you select *Specific range*, specify start and end dates. If the **Start date** field is left blank, all activity is included up to the end date. If the **End date** field is left blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.
Include inactive products and billing items. You can mark this checkbox to include products and billing items with a status of Inactive.

Show grade/amount schedule for automatic billing items. You can mark this checkbox to include grade levels and schedules.

Show pricing schedule for products. You can mark this checkbox to include the pricing schedule for each product.

Create an output query of products and billing items. If you mark this checkbox, the program creates a query of products and billing items included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters on the action bar to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
Columns Tab

On the Columns tab, you can select the columns to appear on the Product and Billing Item List, for example, Type, Description, and Status.

Field Name. Select the fields to appear as columns on the report.

To remove a column from the report, click the column entry and select the blank item. To add a column, click the Field Name column of the empty row and select the data to appear in the new column. To change the order of the columns on the report, select a row in the grid and click the up or down arrow buttons on the action bar.

Field Align. Select the alignment for the text within the column. This affects only the alignment of the data; you set the alignment for the headings in the Heading Align field.

Heading. You can enter a different heading for the column.

Heading Align. Select the alignment for the column heading.

Wrap Heading? Mark this checkbox to wrap heading text to the next line when it reaches the right edge of the column. If you leave this checkbox unmarked, column headers are cut off when they reach the right edge of the column.

Width. Enter the width of each column. The Report Width label, on the bottom right corner of the screen, indicates the total width of the combined columns. If this value exceeds the page width, it turns red.

Wrap Field? Mark this checkbox to wrap field text to the next line when it reaches the right edge of the column. If you leave this checkbox unmarked, column content is cut off when it reaches the right edge of the column.
Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Product and Billing Item List. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
Sort. Use Sort to select the order in which information appears on the report. When you select Sort, you can sort within categories in the grid on the right. Select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.

To print each category selected in the Sort by column on its own page, mark Page break on each new.

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use Miscellaneous to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

![Color Scheme Screen](image)

**Product and Billing Item Report**

The Product and Billing Item Report provides detailed information about products and billing items, such as school fees, for a date or date range you select.

The Product and Billing Item Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Include products and billing items with these valid dates.** In this field, select a date, date range, or billing cycle for products and billing items to include in the report. These are the dates from the product and billing item record.

If you select <Specific range>, specify start and end dates. The product and billing item’s date must fall within this range. If you select Today, Yesterday, Tomorrow, or <Specific date>, the product and billing item’s start date must be on or after the selected date. The field name changes to **Valid dates on or after**.

**Include the following product and billing item information.** You can include pricing and sales tax information by marking checkboxes:

- Pricing schedule details for products
- Sales tax entity details for sales tax items
- Schedules and grade distributions
- Restrictions
- Attributes
- Notes

**Include inactive products and billing items.** You can include product and billing items with a status of Inactive.
Create an output query of product and billing items. If you mark this checkbox, the program creates a query of the products and billing items included in the report. You can use the query later in other areas of Student Billing.


Filters Tab
On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Products and Billing Items filter, only the products and billing items you select appear in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab
On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Product and Billing Item Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to select details specific to the Product and Billing Item Report. You can mark checkboxes to show distributions by transaction characteristic. If you have the optional module *Projects and Grants* and have defined transaction codes, additional checkboxes appear.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To print each category selected in the **Sort by** column on its own page, mark **Page break on each new**.
Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
# Reconciliation Reports

## Contents

<table>
<thead>
<tr>
<th>Report</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Distribution Report</td>
<td>148</td>
</tr>
<tr>
<td>General Tab</td>
<td>149</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>150</td>
</tr>
<tr>
<td>Format Tab</td>
<td>150</td>
</tr>
<tr>
<td>Aged Accounts Receivable Report</td>
<td>158</td>
</tr>
<tr>
<td>General Tab</td>
<td>158</td>
</tr>
<tr>
<td>Address Tab</td>
<td>159</td>
</tr>
<tr>
<td>Format Tab</td>
<td>160</td>
</tr>
<tr>
<td>Open Item Report</td>
<td>167</td>
</tr>
<tr>
<td>General Tab</td>
<td>168</td>
</tr>
<tr>
<td>Format Tab</td>
<td>168</td>
</tr>
</tbody>
</table>
Reporting categories in **Student Billing** include Action Reports, Analysis Reports, Bank Account Reports, Custom Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Reconciliation Reports, Student/Individual/Organization Reports, and Transaction Reports. This chapter discusses Reconciliation Reports. For information about other report categories, see the chapter for that category. For information about Pivot Reports, see the *Pivot Reports Guide* for The Financial Edge.

**Student Billing** Reconciliation Reports are designed to help you reconcile your student billing subledger transactions with your general ledger. These reports have predefined defaults to help you identify the transactions that are part of your subledger balance. Some transactions may prevent these reports from balancing to your general ledger. You can use these reports to determine if transactions have posted properly, and which subsidiary ledger transactions are causing a difference in your general ledger balance.

The **Student Billing** Reconciliation Reports (Account Distribution Report, Aged Accounts Receivable Report, and Open Item Report) are similar to the analysis and transaction reports with the same names, however the reconciliation reports have predefined defaults to help you identify the transactions that are part of your subledger balance.

For the Reconciliation Reports category, you can create these reports:
- Account Distribution Report
- Aged Accounts Receivable Report
- Open Item Report

**Account Distribution Report**

The Account Distribution Report for reconciliation is similar to the transaction report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subledger activity.

The Account Distribution Report lists debit and credit amounts for accounts in **General Ledger** created by **Student Billing** transactions and adjustments. If you void payments from students or parents and create bank adjustments, they will not appear in the Account Distribution Report. To find adjustment amounts that are part of your reconciliation, you can run a GL General Ledger Report and filter for the journal code used when posting cash management adjustments. You can also run the Bank Register Report and filter on cash management adjustments.

The Account Distribution Report has three tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report as well as the overall appearance of the report. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about information included in the report.

Report format. In the Report format field, select “Detail” or “Summary”. The detail account format can be more useful than the summary account format for locating differences.

Include transactions with these dates. Specify a start date and an end date for the posted transactions you want to include in the report. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

Create an output query of [ ]. If you mark this checkbox, you can select to create a query of accounts, records, charges, credits, refunds, payments or deposits. You can use the query later in other areas of Student Billing.

Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you create the report in detail format, the report prints in landscape.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

![Filter Tab Image]

**Open.** You can click this button to access the Selected Accounts screen on which you select specific accounts to include in the report.

**Clear All Filters.** Click this button to remove all previously selected accounts from the report.

**Filters column.** This column lists the available filters for this report. You cannot edit this column.

**Include column.** In the *Include* column, select “All” or “Selected”. If you choose “Selected,” the Selected Accounts screen opens for you to designate specific accounts.

**Selected Filters column.** After you have selected specific accounts, they appear in the *Selected Filters* column.

Format Tab

On the Format tab, you specify the appearance of the report. The list on the left of the screen displays formatting options for the Account Distribution Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
Criteria. Use **Criteria** to print data which helps you remember the criteria you used to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to select characteristics for which to show distribution information. Mark **Show distribution for these characteristics** to view distributions. If you select one characteristic, you can mark **Show characteristic as a column in the main report body.** The marked characteristic appears as a separate column on the report. If you select multiple characteristics, you can mark **Show transaction total.** The program prints transaction totals in a separate line with the debit or credit amount.
**Grand Totals.** Use **Grand Totals** to show combined totals for transaction characteristics. If you have the optional module *Projects and Grants* and have defined transaction codes, additional checkboxes appear.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per Account Number** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new Account Number**.

![New Account Distribution Report](image)
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

![Page Footer](image)

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer](image)
**Miscellaneous.** Use *Miscellaneous* to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use *Color Scheme* to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. When you leave *Apply a Color Scheme* unmarked, the reports prints in black and gray.
Aged Accounts Receivable Report

The Aged Accounts Receivable Report for reconciliation is similar to the analysis report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subledger balance.

The Aged Accounts Receivable Report provides a list of charge balances distributed to aging periods. This report is useful for determining past due and current balances of records who own or are assigned activity. For example, you can run the Aged Accounts Receivable Report to quickly see past due balances of your school’s student, individual, and organization accounts.

The Aged Accounts Receivable Report is different than the Aged Accounts Payable Report. In Accounts Payable, payments are included or excluded based on the “age as of date”. In Student Billing, charges, payments, and credits are included based on the transaction date filters. The “aging as of date” is independent of the transactions.

The Aged Accounts Receivable Report has three tabs on which you set parameters: General, Address, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report as well as the overall appearance of the report. For more information about creating a report, see “Creating Reports” on page 12.

General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Calculate aging as of. In the Calculate aging as of field, enter a specific date for the aging period.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of records or charges included in the report. You can use the query later in other areas of Student Billing.
**Report orientation.** In this field, select “Portrait” or “Landscape”.

### Address Tab

On the Address tab, you select the address from which the program uses contact information. For more information about addresses, see the *Records Guide for Student Billing*.

**Include contact information for addresses.** You can mark this checkbox to include contact information on the report.

**Validate addresses as of.** Select Today, Tomorrow, Last day of this week, Last day of this month, or <Specific date> as the date to use when determining which address to check for contact information.

**Consider seasonal addresses.** Mark this checkbox to include seasonal addresses when checking for contact information.

**If no seasonal addresses are found, consider these addresses.** In the Addresses box, select an address type and click the right arrow to move it to the **Addresses to consider, in order of importance** box. Address types that you move to the **Addresses to consider, in order of importance** box are considered when checking for contact information. The first address type in the list that matches the date selected in the **Validate addresses as of** field is included. You can change the order of addresses in the **Addresses to consider, in order of importance** box by selecting an address type and clicking the up and down arrows next.
In the grid, in you can include or exclude an address based on its attributes. In the **Action** column, select whether to include or exclude an address. In the **Attribute Type** column, select the type of attribute to use, and in the **Value** column, select the attribute value that an address must have to include or exclude it from the report.

**If no address is found.** In the **If no address is found** field, select what to do if the program finds no addresses that match the address types you selected. You can include records without an address or select an address type to use. If you select “Print specific address” in the **If no address is found** field, select the address type to use.

**Format Tab**

On the Format tab, you specify the appearance of the report. The list on the left of the screen displays formatting options for the Aged Accounts Receivable Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

Detail. Use Detail to make selections for the output of the report.

In the Report by field, select Payer Activity or Student Activity to determine how the report displays information. When you select “Student Activity”, the report displays each student and his corresponding activity. When you select “Payer Activity”, the report displays each payer (student, individual, or organization) and is broken down by the records the payer is responsible for.

Then select Show or Do not show transaction details. Show lists payers or students with their individual transaction information and balances. Do not show lists transactions without payer or student information.

If you report by student activity and select not to show transaction details, you can mark Group transactions by General Ledger receivable account information. The report will show GL information for the selected transactions.

Mark Show transaction detail to list the transaction date, type, ID, due date, aging period, and amount for each transaction that in a balance.

To summarize aging by product and billing item, mark Include summary by product and billing item. This creates a chart on the last page of the report totaling the amount due for each product and billing item under the appropriate aging period.
If you marked **Include contact information for addresses** on the Address tab, you can select whether to print the contact information for individuals and organizations. In the **Print** field, select **All contact types** or **Selected contact types**. If you choose **Selected contact types**, then select the types in the **Contact types** box and move them to the **Selected contact types** box.

---

**GL Sort/Break.** Use **GL Sort/Break** to select the order for general ledger account information to appear on the report and where breaks fall. You can use **GL Sort/Break** only if you marked **Group transactions by General Ledger receivable account information** in **Detail**. Sorting and breaking by general ledger accounts makes it easier to reconcile with **General Ledger**. **GL Sort/Break** sorts and breaks the entire report, whereas **Transaction Sort/Break** sorts and breaks each payer/student section within the report.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column. To create breaks, you can mark the checkbox in the **Break?** column.

If you mark the checkbox in the **Break?** column, the **Break Header for** frame is enabled so you can specify more information about the break for the selection in the **Sort by** column. For example, if you select Account Number in the **Sort by** column, and mark the checkbox in the **Break?** column, in the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

---

**New Aged Accounts Receivable Report**

**GL Sort/Break**

- **Account Number**
  - **Sort by**: Ascending
  - **Order by**: Sort by Account Number
  - **Break**
    - **Text before value**: 
    - **Text after value**: 
  - **Break Header for Account Number**:
    - **Print count per Account Number**
    - **Print count as a percentage of total**
    - **Page break on each new Account Number**
Page Footer. Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

![Page Footer](image)

Report Footer. Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer](image)
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.
Name Formats. Use Name Formats to select the format of organization, individual, and student names in the report.

In the Organization frame, mark Use name followed by Organization ID, CFDA #, or Contact Name. The program displays the items you mark after the organization name in the report.

Selections in the Individuals and Students frames work the same way. In the Select addressee/salutation from field, if you select Record, in the Use field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the Select addressee/salutation from field, if you select Configuration, in the Use field, you can select a name format as defined in Configuration.

In the If not present select addressee/salutation from field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

Transaction Sort/Break. Use Transaction Sort/Break to select the order for transactions to appear on the report and where breaks fall. Transaction Sort/Break sorts and breaks each payer/student section within the report, whereas GL Sort/Break sorts and breaks the entire report.
To order the information, you can select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break? for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count as a percentage of total for the selected sorting category. To start the selected sorting category on a new page, mark Page break on each new.

---

**Open Item Report**

The Open Item Report for reconciliation is similar to the analysis report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subledger balance.

The Open Item Report lists charges that have not been completely paid and the amount remaining to be paid as of a selected date. This report is useful for reconciling to the general ledger.

The Open Item Report has two tabs on which you set parameters: General and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report as well as the overall appearance of the report. For more information about creating a report, see “Creating Reports” on page 12.

This report is designed to help you with your reconciliation process. However, if you need additional date and filtering options for this report, see “Open Item Report” on page 60.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Show transactions open as of. In the Show transactions open as of field, specify a date for transactions to include. All transactions open as of this date are included.

Create an output query of []. If you mark this checkbox, the program creates a query of the records or charges included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select “Portrait” or “Landscape”.

Format Tab

On the Format tab, you specify the appearance of the report. The list on the left of the screen displays formatting options for the Open Item Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to **Open Item Report** in the **Title** field. You can leave this as the title for your report or enter your own.
The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

Detail is important in determining the output of the report.

Mark **Include record open item information** to include open item information in detail or by summary. If you do not mark this option, you can use this report as a product and billing summary.

In the **Report by** field, select Student Activity or Payer Activity to determine how the report displays information.

Then select Show or Do not show transaction details. Show lists payers or students with their individual transaction information and balances. Do not show lists transactions without payer or student information.

The **Report in** field determines the layout of the report. Detail lists individual transaction information. Summary creates a column for each transaction type charge, payment, and credit, and issues a total for each.
Reporting By Payer Activity in Detail: Show transaction details

**Detail**

- Include record open item information
- Report by: Payor Activity
- Report in: Detail and Show transaction details

---

### Community Services Inc.

**Open Item Report**

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Current Record Type</th>
<th>Type</th>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
<th>Method</th>
<th>Credits</th>
<th>Balance</th>
<th>% Share</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Grand Total:** $19,396.50

---

Reporting By Payer Activity in Detail: Do not show transaction details

**Detail**

- Include record open item information
- Report by: Payor Activity
- Report in: Detail and Do not show transaction details

---

### Community Services Inc.

**Open Item Report**

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Current Record Type</th>
<th>Type</th>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
<th>Method</th>
<th>Credits</th>
<th>Balance</th>
<th>% Share</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Grand Total:** $19,396.50

---
Reporting By Payer Activity in Summary: Show transaction details

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Current Grade</th>
<th>Record Type</th>
<th>Charge Amount</th>
<th>Payments</th>
<th>Credits</th>
<th>Balance</th>
<th>% Unpaid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thomas London</td>
<td>$4,002.85</td>
<td>$817.20</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$3,185.65</td>
<td>79.51%</td>
</tr>
<tr>
<td>Sarah Smith</td>
<td>$4,735.60</td>
<td>$859.20</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$3,876.40</td>
<td>82.04%</td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$2,042.05</td>
<td>94.00%</td>
</tr>
</tbody>
</table>

Reporting By Payer Activity in Summary: Do not show transaction details

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Current Grade</th>
<th>Record Type</th>
<th>Charge Amount</th>
<th>Payments</th>
<th>Credits</th>
<th>Balance</th>
<th>% Unpaid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thomas London</td>
<td>$4,002.85</td>
<td>$817.20</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$3,185.65</td>
<td>79.51%</td>
</tr>
<tr>
<td>Sarah Smith</td>
<td>$4,735.60</td>
<td>$859.20</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$3,876.40</td>
<td>82.04%</td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$2,042.05</td>
<td>94.00%</td>
</tr>
</tbody>
</table>
### Reporting By Student Activity in Detail: Show transaction details

#### Community Services Inc. Open Item Report

<table>
<thead>
<tr>
<th>Transaction Details</th>
<th>Current</th>
<th>Record</th>
<th>Branch</th>
<th>Date</th>
<th>Type</th>
<th>Title</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Executive Elizabeth Condon</strong></td>
<td>07</td>
<td>Student</td>
<td>905539</td>
<td>226</td>
<td>TUITION AND</td>
<td>$14,402.00</td>
<td>$9,112.50</td>
</tr>
<tr>
<td><strong>Executive Elizabeth Condon</strong></td>
<td>07</td>
<td>Student</td>
<td>905539</td>
<td>227</td>
<td>B-0865</td>
<td>$250.00</td>
<td>$5.00</td>
</tr>
<tr>
<td><strong>Total for Executive Elizabeth Condon</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$14,652.00</td>
<td>$9,117.50</td>
</tr>
<tr>
<td><strong>Grand Total for Executive Elizabeth Condon</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$14,652.00</td>
<td>$9,117.50</td>
</tr>
</tbody>
</table>

#### Reporting By Student Activity in Detail: Do not show transaction details

#### Community Services Inc. Open Item Report

<table>
<thead>
<tr>
<th>Transaction Details</th>
<th>Current</th>
<th>Record</th>
<th>Branch</th>
<th>Date</th>
<th>Type</th>
<th>Title</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Executive Elizabeth Condon</strong></td>
<td>07</td>
<td>Student</td>
<td>905539</td>
<td>226</td>
<td>TUITION AND</td>
<td>$14,402.00</td>
<td>$9,112.50</td>
</tr>
<tr>
<td><strong>Executive Elizabeth Condon</strong></td>
<td>07</td>
<td>Student</td>
<td>905539</td>
<td>227</td>
<td>B-0865</td>
<td>$250.00</td>
<td>$5.00</td>
</tr>
<tr>
<td><strong>Total for Executive Elizabeth Condon</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$14,652.00</td>
<td>$9,117.50</td>
</tr>
<tr>
<td><strong>Grand Total for Executive Elizabeth Condon</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$14,652.00</td>
<td>$9,117.50</td>
</tr>
</tbody>
</table>
Reporting By Student Activity in Summary: Show transaction details

### Detail

- Include record open item information
- Report by: Student Activity
- Report in: Summary
- Show transaction details

#### Community Services Inc.
Open Item Report

<table>
<thead>
<tr>
<th>Transactions</th>
<th>Current Balance</th>
<th>Record Type</th>
<th>Charge Amount</th>
<th>Payments</th>
<th>Credit</th>
<th>Balance</th>
<th>Multiplier</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Care</td>
<td>$9,802.00</td>
<td>$9,802.00</td>
<td>$100.00</td>
<td></td>
<td></td>
<td>$9,802.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Reporting By Student Activity in Summary: Do not show transaction details

### Detail

- Include record open item information
- Report by: Student Activity
- Report in: Summary
- Do not show transaction details

#### Community Services Inc.
Open Item Report

<table>
<thead>
<tr>
<th>Transactions</th>
<th>Current Balance</th>
<th>Record Type</th>
<th>Charge Amount</th>
<th>Payments</th>
<th>Credit</th>
<th>Balance</th>
<th>Multiplier</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Care</td>
<td>$9,802.00</td>
<td>$9,802.00</td>
<td>$100.00</td>
<td></td>
<td></td>
<td>$9,802.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you report by student activity and select not to show transaction details, you can mark **Group transactions by General Ledger receivable account information**. The report will show GL information for the selected transactions.
To summarize open items by product and billing item, mark **Include summary by product and billing item**. This creates a chart on the last page of the report totaling the amount due for each product and billing item.

**GL Sort/Break.** **GL Sort/Break** to select the order for general ledger account information to appear on the report and where breaks fall. You can use **GL Sort/Break** only if you mark **Group transactions by General Ledger receivable account information** in **Detail**. Sorting and breaking by general ledger accounts makes it easier to reconcile with **General Ledger**. **GL Sort/Break** sorts and breaks the entire report, whereas **Transaction Sort/Break** sorts and breaks each student/payer section within the report.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column. To create breaks, you can mark the checkbox in the **Break?** column.

If you mark the checkbox in the **Break?** column, the **Break Header for** frame is enabled so you can specify more information about the break for the selection in the **Sort by** column. For example, if you select Account Number in the **Sort by** column, and mark the checkbox in the **Break?** column, in the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

![Page Footer](image)

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer](image)
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

![Screenshot of Miscellaneous settings](image)

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

![Screenshot of Color Scheme settings](image)
Name Formats. Use Name Formats to select the format of organization, individual, and student names in the report.

In the Organization frame, mark Use name followed by Organization ID, CFDA #, or Contact Name. The program displays the items you mark after the organization name in the report.

Selections in the Individuals and Students frames work the same way. In the Select addressee/salutation from field, if you select Record, in the Use field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the Select addressee/salutation from field, if you select Configuration, in the Use field, you can select a name format as defined in Configuration.

In the If not present select addressee/salutation from field, if you select Full name in the Use field, the If not present select addressee/salutation from field is disabled.

Transaction Sort/Break. Use Transaction Sort/Break to select the order for information to appear on the report and where breaks fall between sets of information. When you select Transaction Sort/Break, you can sort sections within the report in the grid on the right. Select a sorting category in the Sort by column and select Ascending or Descending in the Order by column. To create breaks between the sections you have sorted by, you can mark the checkbox in the Break? column.

In the Break Header for <Sort by category> frame, in the Text before value and Text after value fields, you can enter up to 30 characters in each field for information that prints immediately before and after each break.
In the **Break Footer for <Sort by category>** frame, you can mark **Print count per <Sort by category>** or **Print count as percentage of total** to print the information in the footer. To start a new page for the highest level break, mark **Page break on each new <Sort by category>**.
# Student/Individual/Organization Reports

## Contents

- **Account Balance Report** ................................................................. 182
  - General Tab .................................................................................. 183
  - Filters Tab .................................................................................. 184
  - Format Tab .................................................................................. 184
- **Family Directory** ........................................................................... 189
  - General Tab .................................................................................. 190
  - Filters Tab .................................................................................. 191
  - Relationship Filters Tab .............................................................. 192
  - Address Tab .............................................................................. 192
  - Relation Address Tab ................................................................. 194
  - Columns Tab ............................................................................. 195
  - Format Tab .................................................................................. 196
- **Individual Profile Report** ............................................................... 202
  - General Tab .................................................................................. 203
  - Filters Tab .................................................................................. 204
  - Format Tab .................................................................................. 204
- **Organization Profile Report** ............................................................ 207
  - General Tab .................................................................................. 208
  - Filters Tab .................................................................................. 209
  - Format Tab .................................................................................. 209
- **Payment Responsibility Report** ........................................................ 212
  - General Tab .................................................................................. 213
  - Filters Tab .................................................................................. 214
  - Format Tab .................................................................................. 214
- **Record Statistics Report** ................................................................. 219
  - General Tab .................................................................................. 220
  - Filters Tab .................................................................................. 221
  - Format Tab .................................................................................. 221
- **Student Profile Report** ................................................................. 225
  - General Tab .................................................................................. 226
  - Filters Tab .................................................................................. 227
  - Format Tab .................................................................................. 227
Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Profile Reports, Product and Billing Item Reports, Deposit and Receipt Reports, Student/Individual/Organization Reports, and Transaction Reports. This chapter discusses Student/Individual/Organization Reports. For information about other report categories, see the chapter for that category. For information about Pivot Reports, see the *Pivot Reports Guide for The Financial Edge*.

Student/Individual/Organization Reports in *Student Billing* include:

- Account Balance Report
- Family Directory
- Individual Profile Report
- Organization Profile Report
- Payment Responsibility Report
- Record Statistics Report
- Student Profile Report

**Account Balance Report**

The Account Balance Report shows balances for students, individuals, and organizations for a date or date range you select.

The Account Balance Report has tabs on which you set parameters: General, Filters, Columns, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Calculate balance as of.** In this field, select Today or <Specific date> to specify the date for including account balances. If you select <Specific date>, in the Date field, enter the date for which to account balances.

**Include scheduled advance deposits with these dates.** Mark the checkbox and select a date or date range in the Schedule date field to specify the date for including advance deposits. Ungenerated advance deposit amounts for automatic billing items appear on the report as credits.

**Include scheduled financial aid with these dates.** Mark the checkbox and select a date or date range in the Schedule date field to specify the date for including financial aid. Ungenerated financial aid amounts for automatic billing items appear on the report as credits.

**Include records with.** You can mark:

- **No activity** — includes records with no activity
- **A balance over** — includes any positive amount you enter.
- **A credit balance** — includes records with a credit balance
- **A zero balance** — includes records with a zero balance

**Create an output query of records.** You mark this checkbox, the program creates a query of the records included in the report. You can use the query later in other areas of Student Billing.
Click **Preview** at any time to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

**Report orientation.** In this field, select Portrait or Landscape.

### Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

![New Account Balance Report](image)

**Open.** Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters.** The **Filters** column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the **Include** column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the **Selected Filters** column.

### Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Account Balance Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

Detail. Use Detail to make selections for the output of the report.
In the **Report by** field, select Payer Activity or Student Activity to determine how the report displays information. When you select “Student Activity”, the report displays each student and his corresponding activity. When you select “Payer Activity”, the report displays each payer (student, individual, or organization) and is broken down by the records the payer is responsible for.

Then select Show or Do not show transaction details. Show lists payers or students with their individual transaction information and balances. Do not show lists transactions without payer or student information.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To print each category selected in the **Sort by** column on its own page, mark **Page break on each new**.
Page Footer. Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

Report Footer. Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports print in black and gray.

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report.

In the **Organization** frame, mark **Use name followed by Organization ID,** **CFDA #,** or **Contact Name.** The program displays the items you mark after the organization name in the report.
Selections in the Individuals and Students frames work the same way. In the Select addressee/salutation from field, if you select Record, in the Use field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the Select addressee/salutation from field, if you select Configuration, in the Use field, you can select a name format as defined in Configuration.

In the If not present select addressee/salutation from field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

If you select Full name in the Use field, the If not present select addressee/salutation from field is disabled.

Family Directory

The Family Directory provides a list of students and relationships with address information. The report first determines the students to include in the directory and then finds the relationships for those students. The directory lists the information by the name of the relationship. You can include the student’s name in a column in the report.

You can select the number of column groups to use on the report and combine entries for spouses, such as a student’s parents. To combine entries for a married couple, they both must be specified as relationships on the student record, and they must have a relationship between them defined with Spouse marked on their records. For more information about defining relationships, see the Students chapter of the Records Guide for Student Billing.
The Family Directory has tabs on which you set parameters: General, Filters, Relationship Filters, Address, Relation Address, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

### Show in [ ] column(s).

Select how many columns to print in the directory. You can print up to four columns.

### Combine entries for each spouse pair.

To combine entries for spouses, mark this checkbox. For example, if a husband and wife have separate records, marking the checkbox combines their contact information into a single entry in the directory, for example, Mr. & Mrs. William Smith.

### Create an output query of students.

If you mark this checkbox, the program creates a query of the student records created for the report. You can use the query later in other areas of **Student Billing**.

### Report orientation.

In this field, select Portrait or Landscape.

---

Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Students filter, only selected students appear in the report.
Relationship Filters Tab

On the Relationship Filters tab, you can filter the types of student relationships to include in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

<table>
<thead>
<tr>
<th>Filters</th>
<th>Include</th>
<th>Selected Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship Types</td>
<td>All</td>
<td>&lt;All Relationship Types&gt;</td>
</tr>
<tr>
<td>Related Records</td>
<td>All</td>
<td>&lt;All Related Records&gt;</td>
</tr>
</tbody>
</table>

**Filters.** The *Filters* column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the *Include* column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the *Selected Filters* column.

**Limit results to.** Select to limit relationship filters by selecting Ignore, Include only, or Exclude in the Payers and Statement recipients fields.

Address Tab

On the Address tab, you select the address to use when printing address information in a report. The program compares the parameters you define on this tab with address information entered on the Addresses tab of records to identify the address to use.
On this tab, you select a validation date and then define the order in which the program evaluates address types. The program first checks the validation date, then seasonal addresses, other address types (in the order you specify), and attributes. The first address found on the record that meets the defined parameters is used in the report. You can specify what to do if no valid address is found. For more information about addresses, see the Records Guide for Student Billing.

**Validate addresses as of.** Select the date to use when determining which address to include in the directory. The address at which the student lives on the date you select will be included.

**Consider seasonal addresses.** To include seasonal addresses for students in the directory, mark this checkbox.

**If no seasonal addresses are found, consider these addresses.** In the Addresses box, select an address type and click the right arrow to move it to the Addresses to consider, in order of importance box. Address types that you move to the Addresses to consider, in order of importance box are considered for inclusion in the directory. The first address type in the list that matches the date selected in the Validate addresses as of field is included.

You can change the order of addresses in the Addresses to consider, in order of importance box by selecting an address type and clicking the up and down arrows next.

In the grid, in you can include or exclude an address based on its attributes. In the Action column, select whether to include or exclude an address. In the Attribute Type column, select the type of attribute to use, and in the Value column, select the attribute value that an address must have to include or exclude it from the report.
If no address is found. In the If no address is found field, select what to do if the program finds no addresses that match the address types you selected. You can print students without an address or select an address type to use. If you select Print specific address in the If no address is found field, select the address type to use.

Relation Address Tab

On the Relation Address tab, you select the address to use when printing relationships’ address information in a report. The program compares the parameters you define on this tab with address information entered on the Addresses tab of relationship records to identify the address to use.

On this tab, you select a validation date and then define the order in which the program evaluates address types. The program first checks the validation date, then seasonal addresses, other address types (in the order you specify), and attributes. The first address found on the record that meets the defined parameters is used in the report. You can specify what to do if no valid address is found. For more information about addresses, see the Records Guide for Student Billing.

Validate addresses as of. Select the date to use when determining which address to include in the directory. The address at which the student lives on the date you select will be included.

Consider seasonal addresses. To include seasonal addresses for students in the directory, mark this checkbox.
If no seasonal addresses are found, consider these addresses. In the Addresses box, select an address type and click the right arrow to move it to the Addresses to consider, in order of importance box. Address types that you move to the Addresses to consider, in order of importance box are considered for inclusion in the directory. The first address type in the list that matches the date selected in the Validate addresses as of field is included. You can change the order of addresses in the Addresses to consider, in order of importance box by selecting an address type and clicking the up and down arrows next.

In the grid, in you can include or exclude an address based on its attributes. In the Action column, select whether to include or exclude an address. In the Attribute Type column, select the type of attribute to use, and in the Value column, select the attribute value that an address must have to include or exclude it from the report.

If no address is found. In the If no address is found field, select what to do if the program finds no addresses that match the address types you selected. You can print students without an address or select an address type to use. If you select Print specific address in the If no address is found field, select the address type to use.

Columns Tab

On the Columns tab, you can select the columns to appear in the Family Directory, for example, Student Name, Student Address, and Relation Name.
**Field Name.** Select the fields to appear as columns on the report. To remove a column, select the blank item. To add a column, click the **Field Name** column of the empty row and make your selection. To change the order of the columns on the report, select a row in the grid and click the up or down arrow buttons on the action bar.

**Field Align.** Select alignment for the text in the column. This affects only the alignment of the data; you can set the alignment for the headings in the **Heading Align** field.

**Heading.** You can enter a different heading for the column.

**Heading Align.** Select the alignment for the column heading. To set alignment for data in the column, use **Field Align**.

**Wrap Heading?** Mark this checkbox to wrap heading text to the next line when it reaches the right edge of the column. If you leave this checkbox unmarked, column headers are cut off when they reach the right edge of the column.

**Width.** Enter the width of each column. The Report Width label at the bottom of the screen displays the total width of the combined columns. If this value exceeds the page width, it turns red.

**Wrap Field?** Mark this checkbox to wrap text to the next line when it reaches the right edge of the column. If you leave this checkbox unmarked, column content is cut off when it reaches the right edge of the column.

---

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Family Directory. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to select contact types to print with the address. You can select more than one contact type.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for each category selected in the Sort by column, mark Print count per or Print count as a percentage of total. To start the selected sorting category on a new page, mark Page break on each new.

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

**Name Formats.** Use **Name Formats** to select the format of student and relationship names in the report. Selections in the **Students** and **Relations** frames work the same way.

In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration**.
If you select Full name in the Use field, the If not present select addressee/salutation from field is disabled.

In the If not present select addressee/salutation from field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

Individual Profile Report

The Individual Profile Report provides detailed information about individuals set up in Student Billing. You select the information to include from individual records. The report is useful to quickly review crucial information about individuals without navigating through numerous records.

The Individual Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Show these report sections. Mark the checkboxes in this box to select individual information to include in the report.

Show these details. Mark the checkboxes in this box to select sensitive information about individuals to include in the report.

Show ending balance as of [ ]. To show the individual’s balance amount, mark this checkbox. In the As of date field, select Today or <Specific date> to specify the date for reporting the ending balance. If you select <Specific date>, in the Date field, enter the date for which to show an ending balance.

Reduce balance by ungenerated financial aid? If you mark this checkbox, the program reduces the balance calculations by ungenerated financial aid amounts through the date you select.

Reduce balance by ungenerated advance deposits? If you mark this checkbox, the program reduces the balance calculations by ungenerated advance deposit amounts through the date you select.

Show year-to-date information as [ ]. If you include account summary information in the report, you can mark this checkbox and select to display year-to-date information by fiscal year, calendar year, or beginning on a date you specify.

Create an output query of individuals. If you mark this checkbox, the program creates a query of individual records included in the report. You can use the query later in other areas of Student Billing.
Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

**Report orientation.** In this field, select Portrait or Landscape.

**Filters Tab**

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Individuals filter, only individuals you select appear in the report.

<table>
<thead>
<tr>
<th>Filters</th>
<th>Include</th>
<th>Selected Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individuals</td>
<td>All</td>
<td>&lt;All Individuals&gt;</td>
</tr>
<tr>
<td>Billing Statuses</td>
<td>All</td>
<td>&lt;All Billing Statuses&gt;</td>
</tr>
<tr>
<td>Individual Attributes</td>
<td>All</td>
<td>&lt;All Individual Attributes&gt;</td>
</tr>
</tbody>
</table>

**Open.** Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click Clear All Filters to remove all previously selected filters from the report.

**Filters.** The Filters column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the Selected Filters column.

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Individual Profile Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.
To print each category selected in the Sort by column on its own page, mark Page break on each new.

**Page Footer.** Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

Organization Profile Report

The Organization Profile Report provides detailed information about organizations set up in Student Billing. You select the information to include from organization records. The report is useful to quickly review crucial information about organizations without navigating through numerous records.
The Organization Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Show these report sections.** Mark the checkboxes in this box to select organization information to include in the report.

**Show these details.** Mark the checkboxes in this box to select sensitive information about organizations to include in the report.

**Show ending balance as of [ ].** To show the organization’s balance amount, mark this checkbox. In the **As of date** field, select Today or <Specific date> to specify the date for reporting the ending balance. If you select <Specific date>, in the **Date** field, enter the date for which to show an ending balance.

**Reduce balance by ungenerated financial aid?** If you mark this checkbox, the program reduces the balance calculations by ungenerated financial aid amounts through the date you select.

**Reduce balance by ungenerated advance deposits?** If you mark this checkbox, the program reduces the balance calculations by ungenerated advance deposit amounts through the date you select.
Show year-to-date information as [ ]. If you include account summary information in the report, you can mark this checkbox and select to display year-to-date information by fiscal year, calendar year, or beginning on a date you specify.

Create an output query of organizations. If you mark this checkbox, the program creates a query of organization records included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab
On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab
On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Organization Profile Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
The heading defaults to Organization Profile Report in the Title field. You can leave this as the title for the report or enter your own.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.
To print each category selected in the Sort by column on its own page, mark Page break on each new.

**Page Footer.** Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

Payment Responsibility Report

The payment responsibility report provides payment responsibility and groups the information by owner or recipient.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Report by.** In this field, select Owner or Payer to determine how the report displays the information.

**Display separate page for each.** If you mark this checkbox, the report prints each owner or recipient grouping on a separate page.

**Include payer exceptions.** If you mark this checkbox, the report displays billing item exceptions.

**Include relationship information.** If you mark this checkbox, the report displays relationships and their reciprocals.

**Create an output query of records.** If you mark this checkbox, the program creates a query of records included in the report. You can use the query later in other areas of *Student Billing*.

**Report orientation.** In this field, select Portrait or Landscape.

If you include payer exceptions, report lines appear double-spaced, which uses more paper if you print this report. To save paper, we recommend you unmark **Include payer exceptions**, which displays lines more closely together.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

![Filter Selection Screen]

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column. The Product and Billing Item Attributes filter affects only the billing item exceptions part of the report.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Payment Responsibility Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

The heading defaults to **Payment Responsibility Report** in the **Title** field. You can leave this as the title for the report or enter your own.
**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

<table>
<thead>
<tr>
<th>Headings</th>
<th>Columns</th>
<th>Sort</th>
<th>Page Footer</th>
<th>Miscellaneous</th>
<th>Color Scheme</th>
<th>Name Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

**Name Formats.** Use **Name Formats** to select the format of organization, student, and individual names in the report. Selections in the **Students and Relations** frames work the same way.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name.** The program displays the items you mark after the organization name in the report.

In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select `<Full name>`, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration.**
In the **If not present select addressee/salutation from** field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

---

**Record Statistics Report**

The Record Statistics Report lists students, individuals, or organizations by criteria you select.

The Record Statistics Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Show information for. Mark checkboxes in this box to select student, individual, and client information to include in the report.

Profile bill codes for. Select Today or <Specific date> to specify the date for including bill codes. If you select <Specific date>, in the Date field, enter the date for which to include bill codes.

Create an output query of records. If you mark this checkbox, the program creates a query of records included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Record Statistics Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
The heading defaults to "Record Statistics Report" in the Title field. You can leave this as the title for the report or enter your own.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
Color Scheme. Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

Student Profile Report

The Student Profile Report provides detailed information about students in Student Billing. You select the information to include. The report is useful for quickly reviewing crucial information about students without navigating through numerous records.

The Student Profile Report has tabs on which you parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
A parameter is any field, option, or filter that narrows information in a report and determines the appearance of the report’s output. By specifying parameters, you customize the output results of your report. For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s results.

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Show these report sections. Mark the checkboxes in this box to select student information to include in the report. Each checkbox corresponds to a tab on the student record. Each section you add appears in the report with a separate header.

Show these details. Mark the checkboxes in this box to select sensitive information about students in the report.

Show ending balance as of. To show the balance amounts for students, mark this checkbox and select Today or <specific date> in the As of date field. If you select <specific date>, in the Date field, enter the date for reporting ending balances.

You can mark Reduce balance by ungenerated financial aid? and Reduce balance by ungenerated advance deposits? to reduce the ending balance calculations and account summary balances for ungenerated financial aid and advance deposits.

Show year-to-date information as. In this field, select a year to show a year-to-date summary or student information.

Create an output query of students. If you mark this checkbox, the program creates a query of the student records created for the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Student Profile Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
The heading defaults to Student Profile Report in the Title field. You can leave this as the title for the report or enter your own.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort.** Use **Sort** to select the order in which information appears on the report. When you select **Sort**, you can sort within categories in the grid on the right. Select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To print each category selected in the **Sort by** column on its own page, mark **Page break on each new**.
If you make no selections in the **Sort by** column in the grid, the program sorts by the employee name in ascending order.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
Report Footer. Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

Miscellaneous. Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
Transaction Reports

Contents

Account Activity Report ............................................................. 233
General Tab................................................................. 234
Filters Tab ................................................................. 235
Format Tab ................................................................. 236
Account Distribution Report ..................................................... 242
General Tab................................................................. 243
Filters Tab ................................................................. 244
Format Tab ................................................................. 244
Advance Deposit Report .......................................................... 249
General Tab................................................................. 250
Filters Tab ................................................................. 251
Columns Tab ............................................................... 252
Format Tab ................................................................. 252
EFT Report .......................................................... 257
General Tab................................................................. 258
Format Tab ................................................................. 258
Financial Aid Schedule Detail Report ........................................ 261
General Tab................................................................. 262
Filters Tab ................................................................. 263
Columns Tab ............................................................... 264
Format Tab ................................................................. 265
Financial Aid Schedule Summary Report ................................. 270
General Tab................................................................. 271
Filters Tab ................................................................. 272
Address Tab ............................................................... 272
Format Tab ................................................................. 274
Project Distribution Report ..................................................... 278
General Tab................................................................. 279
Filters Tab ................................................................. 280
Format Tab ................................................................. 280
Sales Tax Report ............................................................ 285
General Tab................................................................. 286
Filters Tab ................................................................. 287
Format Tab ................................................................. 287
Transaction List ............................................................... 292
General Tab................................................................. 293
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filters Tab</td>
<td>294</td>
</tr>
<tr>
<td>Format Tab</td>
<td>294</td>
</tr>
<tr>
<td><strong>Tuition Refund Plan Report</strong></td>
<td>301</td>
</tr>
<tr>
<td>General Tab</td>
<td>302</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>303</td>
</tr>
<tr>
<td>Format Tab</td>
<td>304</td>
</tr>
<tr>
<td><strong>Unapplied Credit Report</strong></td>
<td>308</td>
</tr>
<tr>
<td>General Tab</td>
<td>309</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>310</td>
</tr>
<tr>
<td>Format Tab</td>
<td>310</td>
</tr>
</tbody>
</table>
Reporting categories in *Student Billing* include Action Reports, Analysis Reports, Bank Account Reports, Deposit and Receipt Reports, Product and Billing Item Reports, Student/Individual/Organization Reports, and Transaction Reports. This chapter discusses Transaction Reports. For information about other report categories, see the chapter for that category. For information about Pivot Reports, see the *Pivot Reports Guide* for *The Financial Edge*.

Transaction Reports in *Student Billing* include:

- Account Activity Report
- Account Distribution Report
- Advance Deposit Report
- EFT Report
- Financial Aid Schedule Detail Report
- Financial Aid Schedule Summary Report
- Project Distribution Report
- Sales Tax Report
- Transaction List
- Tuition Refund Plan Report
- Unapplied Credit Report

**Account Activity Report**

The Account Activity Report lists transactions by payer or student for a date or date range you select. It is a versatile report you can use to report on activity generated by students, individuals, and organizations who pay tuition and other fees.

The Account Activity Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
CHAPTER 10

General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

![New Account Activity Report window](image)

**Include.** In this field, select Actual transactions only, Actual and scheduled transactions, or Billing items only.

- Actual transactions only — provides only generated transactions
- Actual and scheduled transactions — provides scheduled but ungenerated transactions from any scheduled billing items added to the record activity
- Billing items — provides only the total amount for scheduled items, whether they are ungenerated, partially generated, or fully generated. You do not see how much is generated or amounts to be generated.

**Transaction date.** In this field, select a date, date range, or billing cycle for the transactions to include in the report.

If you select <Specific range>, specify start and end dates. If you leave the **Start date** field blank, all activity is included up to the end date. If you leave the **End date** field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Include records with.** You can mark:

- **No activity** — includes records with no activity
- **A balance over** — includes any positive amount you enter.
- **A credit balance**
- **A zero balance**

If you mark **A balance over**, records with balances less than or equal to the amount you enter are excluded from the report.
Display a summary balance for transactions before [ ]. To add a line to the report summarizing transactions before a specific date, mark the checkbox and enter a date. You can add a summary balance only if you are creating a detail report.

Show account balance as of [ ]. To include the balance amount, mark this checkbox and enter the end date for reporting the balance.

Create an output query of records. You mark this checkbox, the program creates a query of the records included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.
Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Account Activity Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

Detail. Use Detail to make selections for the output of the report. In the Report by field, select Payer Activity or Student Activity to determine how the report displays the information. When you select “Student Activity”, the report displays each student and his corresponding activity. When you select “Payer Activity”, the report displays each payer (student, individual, or organization) and is broken down by the records the payer is responsible for.

In the Report in [ ] and [ ] transaction details fields, you can further define how the report looks. You can select Detail or Summary and Show or Do not show details.

In the Show [ ] in the payment detail column field, you can select Payment Owner Information to include the person who made the payment or you can select Payment comment to include any comments assigned to the payment record.

If you select Payer Activity, you can mark Show payments/credits with their associated charges to print applied portions of credits and payments immediately after the charges they are applied to.
If you report in detail and mark *Show invoice/return line item detail*, you can include line item details using invoice information or the billing item description.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

![Color Scheme](image)

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report. Selections in the **Individuals** and **Students** frames work the same way.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #,** or **Contact Name.** The program displays the items you mark after the organization name in the report.

In the **Select addressee/salutation from** field, if you select **Record,** in the **Use** field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select **Configuration,** in the **Use** field, you can select a name format as defined in **Configuration.**
If you select Full name in the Use field, the If not present select addressee/salutation from field is disabled.

In the If not present select addressee/salutation from field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

Account Distribution Report

The Account Distribution Report lists debit and credit amounts for accounts in General Ledger created by Student Billing transactions and adjustments.

The Account Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Report format. In the Report format field, select Detail or Summary.

Include transactions with these dates. In this frame, you can select a date, date range, or billing cycle for the transactions to include in the report. Make your selections in the Transaction date and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Include adjustment transactions. You can mark this checkbox to include adjustment transactions. You can make adjustment transactions only if you have the optional module Cash Management.

Include miscellaneous entries. You can mark this checkbox to include miscellaneous entries.

Create an output query of []. If you mark this checkbox, you can select to create a query of the accounts, records, charges, credits, refunds, payments or deposits. You can use the query later in other areas of Student Billing.

Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you create the report in detail format, the report prints in landscape.

A miscellaneous entry is a one-time adjustment you can use in lieu of negative cash amounts.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Departments filter, only the departments you select are used in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Account Distribution Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.
When using Detail and Grand Totals, you can use the Up and Down buttons to order the characteristics that appear on the report.

**Detail.** Use **Detail** to select characteristics for which to show distribution information. Mark **Show distribution for these characteristics** to view distributions. If you select one characteristic, you can mark **Show characteristic as a column in the main report body.** The marked characteristic appears as a separate column on the report. If you select multiple characteristics, you can mark **Show transaction total.** The program prints transaction totals in a separate line with the debit or credit amount.

**Grand Totals.** Use **Grand Totals** to show combined totals for transaction characteristics. If you have the optional module Projects and Grants and have defined transaction codes, additional checkboxes appear.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.
In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count as a percentage of total for the selected sorting category. To start the selected sorting category on a new page, mark Page break on each new.

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports print in black and gray.

---

**Advance Deposit Report**

The Advance Deposit Report lists students, individuals, and organizations who have advance deposit schedules. The report shows detailed information, such as the total amount for the advance deposit, the amount generated, and the remaining amount to be scheduled. You can run the report to see information by payers or payees. Advance deposits are similar to charges in that you can apply payments to them.

The Advance Deposit Report has tabs on which you set parameters: General, Filters, Columns, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

![New Advance Deposit Report](image)

**Include advance deposits with these dates.** In this frame, you can select a date, date range, or billing cycle for the advance deposits to include in the report. Make your selections in the **Transaction dates**, **Payment dates**, **Scheduled dates**, and **Due dates** fields.

If you select <Specific range>, specify start and end dates. If you leave the **Start date** field blank, all activity is included up to the end date. If you leave the **End date** field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Include advance deposits that are.** In this frame, mark **Fully generated**, **Partially generated**, or **Ungenerated** to include certain advance deposits. You can mark one, two, or all three checkboxes, but you must mark at least one.

Mark **Fully funded**, **Partially funded**, or **Unfunded** to include advance deposits with certain statuses. You can mark one, two, or all three checkboxes, but you must mark at least one.

**Report by.** You can select to group advance deposits by advance deposit only or a combination of payer and advance deposit. Select **Advance deposit** to create a row in the report for each advance deposit. Select **Payer** to create a row for each payer/advance deposit combination.
**Include advance deposit notes.** Mark this checkbox to include notes in the report about the advance deposits. Notes are recorded on the Attributes/Notes tab of the advance deposit record. If you run the report by payer, notes appear for each advance deposit with the same payer.

**Create an output query of [ ].** If you mark this checkbox, the program creates a query of the records or advance deposits created for the report. You can use the query later in other areas of *Student Billing*.

**Report orientation.** In this field, select Portrait or Landscape.

---

**Filters Tab**

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

---

**Open.** Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click Clear All Filters to remove all previously selected filters from the report.

**Filters.** The Filters column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the Selected Filters column.
Columns Tab

On the Columns tab, you can select the columns to appear on the Advance Deposit Report, for example, Billing Status, Current Grade and Comments.

Field Name. Select the fields to appear as columns on the report.

To remove a column from the report, click the column entry and select the blank item. To add a column, click the Field Name column of the empty row and select the data to appear in the new column. To change the order of the columns on the report, select a row in the grid and click the up or down arrow buttons on the action bar.

Align. Select the alignment for the text within the column. This affects only the alignment of the data; set the alignment for the headings in the Heading Align field.

Heading. You can enter a different heading for the column.

Heading Align. Select the alignment for the column heading.

Width. Enter the width of each column. The Report Width label, on the bottom right corner of the screen, indicates the total width of the combined columns. If this value exceeds the page width, it turns red.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Advance Deposit Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.
To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

![Page Footer](image)

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

![Report Footer](image)
Miscellaneous. Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

![Miscellaneous settings](image)

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

![Color Scheme settings](image)

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report. Selections in the **Individuals** and **Students** frames work the same way.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name**. The program displays the items you mark after the organization name in the report.
In the Select addressee/salutation from field, if you select Record, in the Use field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the Select addressee/salutation from field, if you select Configuration, in the Use field, you can select a name format as defined in Configuration.

In the If not present select addressee/salutation from field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

EFT Report

The EFT Report provides a detailed view of any EFT files created from Student Billing. You can use this report to review and archive payroll EFT transactions for your school.

The EFT Report has tabs on which you set parameters: General and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, define parameters and select information to include in the report.

Select an EFT File Name. In the Select an EFT File Name frame, enter the name of the EFT file or click the binoculars to search for the file to include in the report.

This EFT File Was Created Using [ ] Logon Cards. If logon cards were used to create the EFT file, in this field, select the number of cards.

This EFT file was created using a carriage return/line feed. If the EFT file was created using a carriage return or line feed, mark the checkbox.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the EFT Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

**Financial Aid Schedule Detail Report**

The Financial Aid Schedule Detail Report displays financial aid information for students who requested financial aid within a selected academic year. Financial aid schedules can appear on student, individual, and organization, records; only student records can have financial aid applications.

The Financial Aid Detail Report has tabs on which you set parameters: General, Filters, Columns and Format. To move between the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you select the records to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

![New Financial Aid Schedule Detail Report](image)

- **Include financial aid for these dates.** In this frame, you can select a date, date range, or billing cycle for financial aid transactions to include in the report. Make your selections in the Transaction dates field.

  If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

- **Include financial aid schedules that are.** In this frame, mark Fully generated, Partially generated, or Ungenerated to include certain scheduled items. You can mark one, two, or all three checkboxes, but you must mark at least one.

  Mark Report by to report scheduled items by the financial aid recipient or a combination of the recipient and financial aid schedule. Select Financial Aid For to create a row in the report for each financial aid schedule. Select Financial Aid Assigned to create a row for each recipient/financial aid schedule combination.

  Mark Include financial aid schedule notes to include a sub-report of notes on the financial aid fee schedule.

  Mark Include financial aid qualification information to add additional rows of details on the report. Below each recipient or financial aid schedule row, a sub-report displays Category, Type, Qualification Date, Amount Qualify, Grant Date, Amount Granted, and Accepted? columns.

- **Transaction dates** include the dates of the schedule, not individually generated dates. Scheduled dates include the dates of scheduled credits (generated dates). If a financial aid schedule has at least one credit scheduled within the range you select, the report includes the entire financial aid schedule.
Create an output query of[]. If you mark this checkbox, the program creates a query of records or financial aid items included in the report. You can use the query later in other areas of Student Billing.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

<table>
<thead>
<tr>
<th>Filters</th>
<th>Include</th>
<th>Selected Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student Enrollment Status</td>
<td>All</td>
<td>&lt;All Student Enrollment Statuses&gt;</td>
</tr>
<tr>
<td>Student Current Grades</td>
<td>All</td>
<td>&lt;All Student Current Grades&gt;</td>
</tr>
<tr>
<td>Student Grades Enrolled</td>
<td>All</td>
<td>&lt;All Student Grades Enrolled&gt;</td>
</tr>
<tr>
<td>Student Classes</td>
<td>All</td>
<td>&lt;All Student Classes&gt;</td>
</tr>
<tr>
<td>Billing Statuses</td>
<td>All</td>
<td>&lt;All Billing Statuses&gt;</td>
</tr>
<tr>
<td>Student Attributes</td>
<td>All</td>
<td>&lt;All Student Attributes&gt;</td>
</tr>
<tr>
<td>Individual Attributes</td>
<td>All</td>
<td>&lt;All Individual Attributes&gt;</td>
</tr>
<tr>
<td>Organization Attributes</td>
<td>All</td>
<td>&lt;All Organization Attributes&gt;</td>
</tr>
<tr>
<td>Financial Aid Billing Items</td>
<td>All</td>
<td>&lt;All Financial Aid Billing Items&gt;</td>
</tr>
<tr>
<td>Financial Aid Attributes</td>
<td>All</td>
<td>&lt;All Financial Aid Attributes&gt;</td>
</tr>
<tr>
<td>Owners</td>
<td>All</td>
<td>&lt;All Owners&gt;</td>
</tr>
<tr>
<td>Financial Aid Types</td>
<td>All</td>
<td>&lt;All Financial Aid Types&gt;</td>
</tr>
<tr>
<td>Financial Aid Categories</td>
<td>All</td>
<td>&lt;All Financial Aid Categories&gt;</td>
</tr>
</tbody>
</table>

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Owners filter, only owners for the selected financial aid appear in the report.

You can double-click a filter in the grid to open the selection screen.
Columns Tab

On the Columns tab, you can select the columns to appear on the Financial Aid Schedule Detail Report, for example, Financial Aid For, Current Grade, and Billing Item.

Field Name. Select the fields to appear as columns on the report.

To remove a column from the report, click the column entry and select the blank item. To add a column, click the Field Name column of the empty row and select the data to appear in the new column. To change the order of the columns on the report, select a row in the grid and click the up or down arrow buttons on the action bar.

Field Align. Select the alignment for the text within the column. This affects only the alignment of the data; you set the alignment for the headings in the Heading Align field.

Heading. You can enter a different heading for the column.

Heading Align. Select the alignment for the column heading.

Wrap Heading? Mark this checkbox to wrap heading text to the next line when it reaches the right edge of the column. If you leave this checkbox unmarked, column headers are cut off when they reach the right edge of the column.

Width. Enter the width of each column. The Report Width label, on the bottom right corner of the screen, indicates the total width of the combined columns. If this value exceeds the page width, it turns red.
**Wrap Field?** Mark this checkbox to wrap field text to the next line when it reaches the right edge of the column. If you leave this checkbox unmarked, column content is cut off when it reaches the right edge of the column.

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Financial Aid Schedule Detail Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Click **Preview** at any time to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

The heading defaults to **Financial Aid Schedule Detail Report** in the **Title** field. You can leave this as the title for your report or enter your own.
The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name.** The program displays the items you mark after the organization name in the report.

Selections in the **Individuals** and **Students** frames work the same way. In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration.**
If you select Full name in the Use field, the If not present select addressee/salutation from field is disabled.

In the If not present select addressee/salutation from field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

Financial Aid Schedule Summary Report

The Financial Aid Schedule Summary Report provides an overview of students receiving financial aid at your school. With this report, you can analyze trends in applications and billing information for financial aid. Financial aid schedules can appear on organization, individual, and student records; only student records can have financial aid applications.

The Financial Aid Summary Report has tabs on which you set parameters: General, Filters, Address and Format. To move between the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you select the records to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Include financial aid for these dates.** In this frame, you can select a date, date range, or billing cycle for financial aid transactions to include in the report. Make your selection in the **Transaction dates** and **Scheduled dates** fields.

If you select <Specific range>, specify start and end dates. If you leave the **Start date** field blank, all activity is included up to the end date. If you leave the **End date** field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Include financial aid schedules that are.** In this frame, mark **Fully generated**, **Partially generated**, or **Ungenerated** to include certain scheduled items. You can mark one, two, or all three checkboxes, but you must mark at least one.

**Group by.** In the **Group by** field, select how to group financial aid in the report. For example, to see financial aid schedules by grade, select Current Grade in the **Group by** field. In the **Sort** field, select Ascending or Descending.

In the **Analyze by** field, you can select how to cross-reference the selection in the **Group by** field. For example, to compare billing items within each grade, select Billing Item in the **Analyze by** field. In the **Sort** field, select Ascending or Descending.

**Create an output query of [ ].** If you mark this checkbox, the program creates a query of records or financial aid schedule included in the report. You can use the query later in other areas of **Student Billing**.
Report orientation. In this field, select Portrait or Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Record Types filter and select Students, only student records appear in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Address Tab

On the Address tab, you select the address to use when printing address information in Financial Aid Schedule Summary Report. The Address tab appears when you select Country, County, Region, State, or ZIP Code on the General tab. For more information about addresses, see the Records Guide for Student Billing.
The report tallies the number of records for your selection in the **Group by** field on the General tab and summarizes the records by your selection in the **Analyze by** field. For example, to create a report that breaks down financial aid data by county, select Financial Aid For in the **Group by** field and County in the **Analyze by** field on the General tab. Use the Address tab to define which addresses to consider when breaking down the number of financial aid recipients living in each county. For more information about addresses, see the *Records Guide for Student Billing*.

**Validate addresses as of.** Select the date to use when determining which address to include in the report. The address at which the student lives on the date you select will be included.

**Consider seasonal addresses.** To include seasonal addresses for students in the report, mark this checkbox.

**If no seasonal addresses are found, consider these addresses.** In the **Addresses** box, select an address type and click the right arrow to move it to the **Addresses to consider, in order of importance** box. Address types that you move to the **Addresses to consider, in order of importance** box are considered for inclusion in the report. The first address type in the list that matches the date selected in the **Validate addresses as of** field is included. You can change the order of addresses in the **Addresses to consider, in order of importance** box by selecting an address type and clicking the up and down arrows next.

In the grid, you can include or exclude an address based on its attributes. In the **Action** column, select whether to include or exclude an address. In the **Attribute Type** column, select the type of attribute to use, and in the **Value** column, select the attribute value that an address must have to include or exclude it from the report.
If no address is found. In the If no address is found field, select what to do if the program finds no addresses that match the address types you selected. You can print students without an address or select an address type to use. If you select Print specific address in the If no address is found field, select the address type to use.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Financial Aid Schedule Summary Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

---

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

**Name Formats.** Use Name Formats to select the format of organization, individual, and student names in the report.

In the Organization frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name**. The program displays the items you mark after the organization name in the report.

Selections in the **Individuals** and **Students** frames work the same way. In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressee/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration**.
In the **If not present select addressee/salutation from** field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

---

**Project Distribution Report**

Use the Project Distribution Report to list debit and credit amounts created by transactions and adjustments in *Student Billing* for projects.

The Project Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Report format.** In the Report format field, select Detail or Summary.

**Include transactions with these dates.** In this frame, you can select a date, date range, or billing cycle for transactions to include in the report. Make your selection in the Transaction date and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Include adjustment transactions.** You can include adjustment transactions.

**Include miscellaneous entries.** You can include miscellaneous entries.

**Create an output query of [ ].** If you mark this checkbox, the program creates a query of the projects, records, charges, credits, refunds, payments, or deposits included in the report. You can use the query later in other areas of Student Billing.

**Report orientation.** In this field, select Portrait or Landscape if you create the report in summary format. If you create the report in detail format, it prints in landscape.

Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

If you select Detail in the Report format field, you can print the report only in landscape orientation.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Projects filter, only projects you select appear in the report.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Project Distribution Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.
**Detail.** Use **Detail** to select transaction characteristics for which to show distribution information. Mark **Show distribution for these characteristics** to view distributions. If you select one characteristic, you can mark **Show characteristic as a column in the main report body**. The marked characteristic appears as a separate column on the report. If you select multiple characteristics, you can select **Show transaction total**. Show transaction total prints a separate line containing each selected characteristic showing the debit or credit amount.

**Grand Totals.** Use **Grand Totals** to show combined totals for transaction characteristics. If you have the optional module Projects and Grants and have defined transaction codes, additional checkboxes appear. You can use the **Up** and **Down** buttons to order the characteristics to appear on the report.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.
To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
**Miscellaneous.** Use Miscellaneous to specify how numbers appear on the report and to set the font size.

**Color Scheme.** Use Color Scheme to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave Apply a Color Scheme unmarked, the reports prints in black and gray.

**Sales Tax Report**

The Sales Tax Report provides detailed or summarized information about sales tax transactions. You can use this report for auditing purposes, showing the source and destination of sales taxes.
The Sales Tax Report has tabs on which you set parameters: General, Filters, Address and Format. To move between the tabs in a report, use **Next** and **Back** at the bottom of the screen or select the tab itself. On these tabs you select the records to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.

**General Tab**

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

**Report format.** In this field, you can select Detail or Summary. If you select Detail, the report displays every transaction that incurred sales tax. If you select Summary, the report shows only the amount of sales tax owed to each sales tax entity.

If you select Summary in the **Report format** field, you can mark **Show GL distribution to each sales tax entity**, and the report includes a summary of the general ledger distribution.

**Include these dates.** In this frame, you can select a date, date range, or billing cycle for transactions to include in the report. Make your selections in the **Transaction date** and **Post date** fields.

If you select <Specific range>, specify start and end dates. If you leave the **Start date** field blank, all activity is included up to the end date. If you leave the **End date** field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

**Create an output query of.** If you mark this checkbox, the program creates a query of the records, charges, credits, or product and billing items included in the report. You can use the query later in other areas of **Student Billing**.

**Report orientation.** In this field, select Portrait or Landscape if you create the report in summary format. If you create the report in detail format, it prints in landscape.
Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

Open a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters**. Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters**. The **Filters** column lists all the filters for the report. You cannot edit this column.

**Include**. By default, in the **Include** column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters**. Filters you specify on the selection screen appear in the **Selected Filters** column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Sales Tax Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization's name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.
To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use Report Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
Miscellaneous. Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.

![New Sales Tax Report](image)

**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

![New Sales Tax Report](image)

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name.** The program displays the items you mark after the organization name in the report.
Selections in the **Individuals** and **Students** frames work the same way. In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select `<Full name>`, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration**.

In the **If not present select addressee/salutation from** field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.

---

**Transaction List**

The Transaction List report provides a list of transactions for selected students, individuals, or organizations over a selected period of time.

The Transaction List has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include transactions with these dates. In this frame, you can select a date, date range, or billing cycle for the transactions to include in the report. Make your selections in the Transaction date, Due date, and Post dates fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Include these transaction types. In this frame, you can select specific transactions to include in the report. Mark the checkboxes for the transaction types to include in the report.

You can mark Only include finance and late charge transactions to include only the transactions with finance or late charge billing items. You can mark Only include transactions whose amounts are greater than [ ] and designate a minimum amount to include. All transactions less than or equal to the amount you enter are excluded from the report.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of records, charges, credits, payments, or refunds included in the report. You can use the query later in other areas of Student Billing.
Click **Preview** at any time to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

**Report orientation.** In this field, select Portrait or Landscape.

**Filters Tab**

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

You can double-click a filter in the grid to open the selection screen.

A filter is a requirement records must meet to be included in a report. For example, if you apply the Records filter, only transactions for the selected records appear in the report.

**Open.** Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters.** The Filters column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the Selected Filters column.

**Format Tab**

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Transaction List. When you select an item in the list, the right side of the screen displays selections for that section of the report.
Headings. Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization's name in the header. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to Transaction List in the **Title** field. You can leave this as the title for your report or enter your own.

Criteria. Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.
**Detail.** Use **Detail** to select details specific to the Transaction List.

To show assignment information for each student instead of summary information, mark **Show assigned to responsibility**. You can mark **Separate columns for charges and credits** to print separate columns instead of one column with charges as positive amounts and credits as negative amounts. To include a summary of charges and credits associated with each billing item, you can mark **Print summary for products and billing items**. If you mark this option, a chart prints at the end of the report listing each billing item and the number of transactions associated with it.

If you do not mark **Show assigned to responsibility**, you can mark **Show distribution for these characteristics** and select the characteristics to include. If you select one characteristic, you can mark **Show characteristic as a column in the main report body**. The marked characteristic appears as a separate column on the report. If you select multiple characteristics, you can select **Show transaction total** and **Show receivables account distribution**. Show transaction total prints the total for each line item. Show receivables account distribution prints the debit and credit distributions for each line item.
**Grand Totals.** Use **Grand Totals** to show combined totals for transaction characteristics. If you have the optional module *Projects and Grants* and have defined transaction codes, additional checkboxes appear. You can use the **Up** and **Down** buttons to order the characteristics to appear on the report.

![Image of transaction report interface]

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark
**Print count per** or **Print count as a percentage of total** for the selected
sorting category. To start the selected sorting category on a new page, mark
**Page break on each new**.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the
page footer and select how to align the text. You can include the page number
and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports prints in black and gray.

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name**. The program displays the items you mark after the organization name in the report.

Selections in the **Individuals** and **Students** frames work the same way. In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select <Full name>, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration**.
If you select Full name in the Use field, the **If not present select addressee/salutation from** field is disabled.

---

**Tuition Refund Plan Report**

The Tuition Refund Plan Report provides information about actual and scheduled charges used to calculate tuition refund insurance premiums. The insurance carrier may require this information in order to process refunds. You can run the report with details or as a summary of charges subject to your tuition refund plan.

The Tuition Refund Plan Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click **Next** and **Back** at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include transactions subject to TRP. In the Include transactions subject to TRP field, select the charges to include in the report:

- Actual and scheduled charges — includes both the generated and ungenerated portions for all billing items you use in TRP calculations and any charges you manually add for billing items marked to include in TRP calculations
- Actual charges only — included only generated amounts from scheduled fees and amounts for manually added charges
- Scheduled charges only — included only ungenerated amounts

Include TRP transactions with these dates. In the Transaction date field, select a date, date range, or billing cycle for the transactions to include in the report.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.
Include scheduled advance deposits with these dates. To include ungenerated advance deposit amounts in the report, mark **Include scheduled advance deposits with these dates**. Select a date or date range for the scheduled advance deposits to include in the report. Ungenerated advance deposit amounts appear as credits against TRP-related charges in the report.

Include scheduled financial aid with these dates. To include ungenerated financial aid amounts in the report, mark **Include scheduled financial aid with these dates**. Select a date or date range for the scheduled financial aid amounts to include in the report. Ungenerated financial aid amounts appear as credits against TRP-related charges in the report.

Create an output query of records. If you mark this checkbox, the program creates a query of records included in the report. You can use the query later in other areas of **Student Billing**.

Report orientation. In this field, select Portrait or Landscape.

**Filters Tab**

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the **Program Basics Guide**.

Open. Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

Clear All Filters. Click **Clear All Filters** to remove all previously selected filters from the report.
A filter is a requirement records must meet to be included in a report. For example, if you apply the Individuals filter, only records for the individuals you select appear in the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting options for the Tuition Refund Plan Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the heading. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.
**Criteria.** Use **Criteria** to print data to help you remember the criteria you use to create the report. Mark **Print these criteria on** and select a separate page or the first page. Your selections print in the criteria section of the report.

The program automatically selects all criteria. Unmark the checkbox for any criteria that should not print on the report.

**Detail.** Use **Detail** to make selections for the output of the report. In the **Report by** field, select Assigned to or Owner to determine how the report displays the information.

In the **Report in [ ] and [ ] Assigned to/Owner details** fields, you can further define how the report looks. You can select Detail or Summary and Show or Do not show details.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.
To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.
**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.

**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.
Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

The Unapplied Credit Report provides a list of students, individuals, and organizations with payments or credits not yet applied to a charge.

The Unapplied Credit Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the report and how the report should look. For more information about creating a report, see “Creating Reports” on page 12.
General Tab

On the General tab, you can select parameters specific to the report and make selections about the information included in the report.

Include credits and payments with these dates. In this frame, you can select a date or date range for unapplied credit transactions to include in the report. Make your selection in the Transaction date and Post dates fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date forward, including transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Include unapplied. In this frame, mark Credits, Payments, or Only include transactions with an unapplied amount greater than [ ] and enter the minimum amount to include. All unapplied amounts less than or equal to the amount you enter are excluded from the report.

Include account balance as of [ ]. You can calculate the account balance up to a date you specify in this field.

Create an output query of [ ]. If you mark this checkbox, the program creates a query of records, credits, or payments included in the report. You can use the query later in other areas of Student Billing.
Click **Preview** at any time to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

**Report orientation.** In this field, select Portrait or Landscape.

**Filters Tab**

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the Program Basics chapter of the *Program Basics Guide*.

**Open.** Select a filter in the grid and click **Open** on the action bar to access the selection screen where you can select specific filters for the report.

**Clear All Filters.** Click **Clear All Filters** to remove all previously selected filters from the report.

**Filters.** The **Filters** column lists all the filters for the report. You cannot edit this column.

**Include.** By default, in the **Include** column, each filter is set to All. To open a selection screen to designate specific filters for the report, choose Selected.

**Selected Filters.** Filters you specify on the selection screen appear in the **Selected Filters** column.

**Format Tab**

On the Format tab, you select how the report will appear. The list on the left of the screen displays formatting options for the Unapplied Credit Report. When you select an item in the list, the right side of the screen displays selections for that section of the report.
**Headings.** Use **Headings** to enter a maximum of 60 characters in the **Title** and **Subtitle** fields. The title and subtitle appear at the top of the report. You can select how to align the heading and whether to include your organization’s name in the heading. You can include the page number and date in the heading. You can also select to include the heading on every page of the report.

The heading defaults to **Unapplied Credit Report** in the **Title** field. You can leave this as the title for your report or enter your own.
Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print these criteria on and select a separate page or the first page. Your selections print in the criteria section of the report.

Detail. Use Detail to select details specific to the Unapplied Credit Report.

In the Report by field, you select which data appears in the first column of the report. You can select Payments/Credits owner to view student activity or Payments/Credits assigned to view payer activity. You can mark Show payment/credit detail to include details of payments and credits.
**Grand Totals.** Use **Grand Totals** to show combined totals for each transaction characteristic. If you have the optional module *Projects and Grants* and have defined transaction codes, additional checkboxes appear. You can use the **Up** and **Down** buttons to select the order in which the characteristics appear on the report.

**Sort/Break.** Use **Sort/Break** to select the order for information to appear on the report and where breaks fall between sets of information.

To order the information, you can select a sorting category in the **Sort by** column and select Ascending or Descending in the **Order by** column.

To create breaks, you can mark the checkbox in the **Break?** column for a sorting category. If you mark **Break?** for a category, fields are enabled so you can specify more information about the break for the selected sorting category.

In the **Text before value** and **Text after value** fields, you can enter up to 30 characters to print directly before and after the value for the selected sorting category.
To print the number or percentage for the selected category in the footer, mark **Print count per** or **Print count as a percentage of total** for the selected sorting category. To start the selected sorting category on a new page, mark **Page break on each new**.

**Page Footer.** Use **Page Footer** to enter a maximum of 254 characters in the page footer and select how to align the text. You can include the page number and date in the footer.
**Report Footer.** Use **Report Footer** to enter a maximum of 254 characters in the report footer and select how to align the text. The report footer appears at the end of the report.

**Miscellaneous.** Use **Miscellaneous** to specify how numbers appear on the report and to set the font size.
**Color Scheme.** Use **Color Scheme** to select colors for report headings. When you click the color box next to the selection, the Color screen appears so you can select a standard color or define a custom color. If you leave **Apply a Color Scheme** unmarked, the reports print in black and gray.

**Name Formats.** Use **Name Formats** to select the format of organization, individual, and student names in the report. Selections in the **Individuals** and **Students** frames work the same way.

In the **Organization** frame, mark **Use name followed by Organization ID, CFDA #, or Contact Name**. The program displays the items you mark after the organization name in the report.

In the **Select addressee/salutation from** field, if you select Record, in the **Use** field, you can select `<Full name>`, Primary addressee, Primary salutation, or any other name format defined on the student or relationship record.

For example, if you select Primary salutation, the report uses the primary salutation defined on the Addressees/Salutations tab of the student and individual records.

In the **Select addressee/salutation from** field, if you select Configuration, in the **Use** field, you can select a name format as defined in **Configuration**.
In the **If not present select addressee/salutation from** field, you can select an alternative name format. The program uses this format if a record does not contain the data used by the primary name format.
Index

A
accessing reports 5
account activity report
overview 233
tabs
filters 235
format 236
general 234
account balance report
overview 182
tabs
filters 184
format 184
general 183
account distribution report
overview 148, 242
tabs
filters 150, 244
format 150, 244
general 149, 243
action listing
overview 28
tabs
filters 29
format 30
general 28
action report
action listing 28
action summary report 34
actions by association report 40
action summary report
overview 34
tabs
filters 36
format 36
general 35
actions by association report
overview 40
tabs
filters 42
format 42
general 41
adding reports 12
advance deposit report
overview 249
tabs
columns 252
filters 251
format 252
general 250
aged accounts receivable report
overview 48, 158
tabs
filters 50
format 52, 160
general 49, 158
analysis report
aged accounts receivable report 48, 158
open item report 60, 167
service and sales analysis report 74
service and sales trend analysis report 80

B
bank account report
bank profile report 88
bank reconciliation report 92
bank register report 97
bank profile report
overview 88
tabs
filters 89
format 89
general 88
bank reconciliation report
overview 92
tabs
format 94
general 93
bank register report
filters button 99
overview 97
tabs
format 101
general 98

C
cash receipts report
overview 112
tabs
filters 114
format 114
general 112
Crystal report, linking with an export file 108
custom report
creating 108
editing export files 110
overview 108

D
deposit and receipt report
cash receipts report 112
deposit list 120
deposit report 126
deposit list
  overview 120
  tabs
    filters 122
    format 122
    general 121
deposit report
  overview 126
  tabs
    filters 128
    format 128
    general 127

E
editing
  export files 110
EFT report
  overview 257
  tabs
    format 258
    general 258
e-mail, sending reports 24
export file, editing for custom reports 110
export, editing for custom reports 110
exporting reports 22

F
family directory
  overview 189
  tabs
    address 192
    columns 195
    filters 191
    format 196
    general 190
    relation address 194
    relationship filters 192
financial aid schedule detail report
  overview 261
  tabs
    columns 264
    filters 263
    format 265
    general 262
financial aid schedule summary report
  overview 270
  tabs
    address 272
    filters 272
    format 274
    general 271

I
individual profile report
  overview 202
  tabs
    filters 204
    format 204
    general 203

O
open item report
  overview 60, 167
  tabs
    filters 62
    format 63, 168
    general 61, 168
organization profile report
  overview 207
  tabs
    filters 209
    format 209
    general 208

P
payment responsibility report
  overview 212
  tabs
    filters 214
    format 214
    general 213
previewing reports 22
printing reports 20
product and billing item list
  overview 134
  tabs
    columns 136
    filters 135
    format 137
    general 134
product and billing item report
  overview 140
  tabs
    filters 142
    format 142
    general 141
product and billing item reports
  product and billing item list 134
  product and billing item report 140
project distribution report
  overview 278
  tabs
    filters 280
    format 280
    general 279
R

record statistics report
  overview 219
  tabs
    filters 221
    format 221
    general 220
report
  accessing 5
  adding 12
  categories 2
  creating 12
  exporting 22
  overview 12
  previewing 22
  printing 20
  sending as email 24

S

sales tax report
  overview 285
  tabs
    filters 287
    format 287
    general 286
service and sales analysis report
  overview 74
  tabs
    filters 76
    format 77
    general 75
service and sales trend analysis report
  overview 80
  tabs
    filters 82
    format 82
    general 81
student profile report
  overview 225
  tabs
    filters 227
    format 227
    general 226
student/individual/organization report
  account balance report 182
  family directory 189
  individual profile report 202
  organization profile report 207
  payment responsibility report 212
  record statistics report 219
  student profile report 225

T

tab
  address 8
  columns 10
  filters 7
  format 7
  general 6
  overview 5
  relationship address 10
  relationship filters 11
transaction list
  overview 292
  tabs
    filters 294
    format 294
    general 293
transaction report
  account activity report 233
  account distribution report 148, 242
  advance deposit report 249
  EFT report 257
  financial aid schedule detail report 261
  financial aid schedule summary report 270
  project distribution report 278
  sales tax report 285
  transaction list 292
  tuition refund plan report 301
  unapplied credit report 308

U

unapplied credit report
  overview 308
  tabs
    filters 310
    format 310
    general 309